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Starting Outlook 

 

In order to use a program, you must start—or launch—it first. 

1. Click on the Start Button.  

2. In the Search Program and Files box type Outlook. 

3. Click on Outlook 2013 from the Program results. 

4. The Microsoft Outlook 2013 program will open. 

 

For quicker access, you might consider pinning the Outlook program to the taskbar or Start menu. 

To do this, right-click Microsoft Outlook 2013 in the All Programs menu and select Pin to Taskbar 

or Pin to Start Menu. 

 

Understanding the Outlook Interface 

 

The Outlook 2013 program screen may seem confusing and overwhelming at first. This lesson will help 

you become familiar with it. 

 

IN THIS CHAPTER 

Starting Outlook 

Understanding the Outlook Interface 

Understanding the Outlook Items 

Understanding the Message Window 

Using the Navigation Pane 

Using the Reading Pane 

Using the To-Do Bar 

Setting up Outlook 

Part of the Microsoft Office 2013 suite of 

programs, Microsoft Outlook 2013 is a 

communication-management program 

that helps you quickly and efficiently 

manage messages, schedules, address 

books, and other information. This guide 

is designed for beginning to intermediate-

level computer users and offers a 

comprehensive look at the features of 

Outlook that most people will use most 

frequently. 

 

Finder / Applications 
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 Quick Access Toolbar: Contains common 

commands such as Send/Receive and Undo. 

You ca add and remove commands as 

desired.  

 Reading Pane: Displays the contents of the 

selected message. 

 Inbox: Lists all of your email messages and 

can be arranged according to your 

specifications. 

 Close Button: Click here to exit the Outlook 

program. 

 Instant Search: Enter key words to search 

the current folder or location. Results 

appear as you enter each search term.  

 Help Button: Click here to open the Outlook 

Help window. 

 Title Bar: Displays the name of the program 

you are currently using (Outlook), and the 

item you are currently working with. 

 Ribbon: The tabs on the Ribbon replace the 

menus and toolbars found in previous 

versions of Outlook. 

 To-Do Bar: Keep tabs on your calendar, 

appointments, and tasks, all in one place. 

The To-Do Bar can also be displayed in a 

minimized format. 

 Navigation Pane: Contains buttons and icons 

ou a  li k to o e a o g Outlook s 
folders and tools. 

Quick Access Toolbar 

Inbox 

Instant Search 

Title Bar 

Reading Pane 

Close Button  Help Button  

Ribbon 

To-Do Bar  

Zoom Slider  

Status Bar  

Navigation Pane  

File Tab  
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 Zoom Slider: Click and drag the slider to 

zoom in or out of an item or view. You can 

also use the + and – buttons.  

 File Tab: Click here to access common 

commands (Open, Print, Save) as well as 

more advanced ones (Automatic Replies, 

Mailbox Cleanup, Rules and Alerts). 

 Status Bar: Displays information and 

reminders about Outlook items. Right-click 

the status bar to specify what information is 

shown.  

 

 

Understanding the Outlook Items 

 

In Outlook, an item is the basic element that holds information. Items are used to send and view e-Mails, 

and also to organize information like tasks and contacts.  

Table 1 - Outlook Items provides an overview of the items used in Outlook. 

 
Mail Message Compose a message to be sent by e-Mail. 

 Appointment Add an appointment to your calendar. 

 
Meeting Request 

Set up an appointment to which you invite other people, or reserve resources 

such as a conference room 

 
Contact 

Enter information about a person including their name, company, job title, and 

e-Mail address. 

 
Contact Group Create a collection of contacts that allows you to quickly send mass e-Mails. 

 
Task Enter to-do items that can be tracked until completion. 

 
Task Request Inform someone else of a task you would like them to perform. 

 
Note Write something quickly in a note. Can be sorted using color categories. 

 

Understanding the Message Window 

 

The Mail message window, like the program window, features the Ribbon in place of menus and toolbars. 

This lesson will help you become familiar with the basic features of the message window. 
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 Quick Access Toolbar: Contains common 

commands such as Send/Receive and Undo. 

You ca add and remove commands as 

desired. 

 Message Area: Type your email message 

here as you would using a word processor. 

 Ribbon: The tabs on the Ribbon replace the 

menus and toolbars found in previous 

versions of Outlook. 

 People Pane: Displays information about the 

person associated with the message. 

 Recipient: Enter the email addresses of 

recipients in the To field. Use the CC field to 

send a copy of the message to recipients 

who are not directly involved, but might be 

interested in the message.  

 

 Subject line: Enter a title here so that 

recipients quickly know the reason for your 

email. 

 Send button: O e ou e fi ished 
composing your message, click the Send 

button to send it. 

 

 File Tab: Click here to access common 

commands (Open, Print, Save) as well as 

more advanced ones (Automatic Replies, 

Mailbox Cleanup, Rules and Alerts). 

 

Outlook 2013 provides easy access to commands through the Ribbon, the File tab, and the Quick Access 

Toolbar. 

Ribbon 

The Ribbon replaces the menus and toolbars found in previous versions of Outlook. The Ribbon keeps 

commands visible while you work instead of hiding them under menus or toolbars. 

Quick Access Toolbar 

Ribbon 

Recipient 

Subject line 

Message Area 

People Pane 

Send 

File Tab  
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The Ribbon is made up of three basic components: 

 Tabs: Commands are organized into tabs on the Ribbon. See Table 1-3: Tabs on the Ribbon for a 

description of the different types of tabs. 

 Groups: The commands found on each tab are organized into groups of related commands.  

 Buttons: To issue a command, click its button on the Ribbon. 

 

File tab 

With the File tab you can access common commands (Open, Print, Save) as well as more advanced ones 

(Accounts Settings, Cleanup Tools, Manage Rules and Alerts). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Quick Access Toolbar 

The Quick Access Toolbar appears above the File tab and provides easy access to the commands you use 

most frequently. The Send/Receive and Undo buttons appear on the toolbar by default; however, you can 

customize this toolbar to meet your needs by adding or removing buttons. 
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Using the Navigation Pane 

 

Outlook is made up of several panes, each with its own set of tools and folders. You can switch between 

these panes using the Navigation Pane. 

 Switch between panes 

The Mail pane appears by default whenever you start Outlook. To switch to another pane, such as 

Calendar or Contacts, use the buttons in the Navigation Pane. 

 

 

 Customize the Navigation Pane 

Click the Configure buttons button in the bottom-right corner of the Navigation Pane. 

 

 

 

 

 

 

To minimize or expand the Navigation Pane, click the Minimize/Expand the Navigation Pane 

button in the upper-right corner of the Navigation Pane; or click the VIEW tab on the Ribbon, 

click the Navigation Pane button in the Layout group, and select an option from the list. 

 

 

 

 

 

 

 

 

 

 

 

Click here to minimize or 

expand the Navigation Pane 

2016 Similar to 2013 
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Using the Reading Pane 

 

You can preview a message without having to open it using the Reading Pane. By default, the Reading 

Pane appears to the right of the Inbox, but you can move the Reading Pane to another position in the 

window. 

Click the VIEW tab on the Ribbon, click the Reading Pane button in the Layout group and select the 

position you want to use. 

 

 

 

 

 

 

 

 

Typically, the Mail folder is the only folder in which the Reading Pane is used extensively. 

You can view messages safely in the Reading Pane— potentially malicious scripts or attachments 

are not activated or opened automatically. 

 

 

Organize Tab / Reading Pane 
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Using the To-Do Bar                                                                                                                                                       

 

Outlook 2013 has a feature called the To-Do bar that pulls together all the things you need to do and 

displays them in a single part of the Outlook screen. The goal of the To-Do bar is to let you know what you 

need to do at a glance rather than making you check your calendar, then check your e-mail Inbox, and 

then check your Task list.  

The ite s ou ll see ost often in the To-Do bar include: 

 Your next few appointments / meetings  

 Tasks ou’ e e te ed  
 E- ail essages ou’ e flagged fo  a tio   

 

Click the VIEW tab on the Ribbon, click the To-Do Bar button in the Layout group, and click the item you 

want to show/hide. 

 

 

 

 

 

 

 

 

To turn off the To-Do Bar, click the VIEW tab on the Ribbon, click the To-Do Bar button in the Layout group, 

and select Off from the list. 

 

Setting up Outlook 

 

You'll need to set up Outlook before you can start using the application to manage your email, contacts, 

calendars, and tasks. The setup process will vary depending on how you plan to use Outlook. If you plan 

to use Outlook in the workplace with an employer-provided email account, it's likely that your account will 

already be set up when you start using Outlook. If not, your office's IT department or supervisor will help 

you with the setup process. 

1. Open Outlook 2013.  

2. From the top Menu select the File tab. 

Not Applicable 

Outlook Menu / Preferences / Accounts 
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3. Above the Account Settings button, click Add Account. 

4. On the Auto Account Setup page, ensure that Email Account is selected and then enter the 

following information:  

 In the Your Name field, enter your name as you want it to appear on your emails. 

 In the E-mail Address field, enter your userid@mta.ca  

 In the Password field, enter your password. Re-enter the password in the Retype Password 

field. 

 Click Next. 

5. Wait for Outlook to find your server. This could take a few minutes. 

6. Click Finish once Outlook has completed configuring your Office 365 account. 

 

 

 

 

 

 

 

 

 

 

mailto:userid@mta.ca
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Using the Email System 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Composing and Sending an Email 

 

This lesson explains how to perform the most basic e-Mail task of all: how to compose and send an e-Mail 

message. 

1. Click the MAIL button in the bottom Navigation Bar. The Inbox appears. 

2. Click the HOME tab on the Ribbon and click the New E-Mail button in the New group. An Untitled 

– Message window appears. 

3. E te  the e ipie t s e-Mail address in the To, Cc and/or Bcc field(s). 

 To: Use for primary message recipients. Usually, these are the people you want to respond to the 

message. Each message must have at least one address in the To box. 

 Cc: Use fo  ou tes  op  e ipie ts. These a e usuall  people ou a t to keep informed about 

the su je t of the e ail essage ut f o  ho  ou do t e ui e a espo se. 
 Bcc: Use fo  li d ou tes  op  e ipie ts. These a e people ou a t to keep i fo ed, ut 
whom you want to keep hidden from other message recipients. Bcc recipients are not visible to any other 

essage e ipie ts a d the efo e a e t i luded i  essage espo ses u less spe ifi all  added to o e 
of the address boxes in the response message. 

IN THIS CHAPTER 

Composing and Sending an Email 

Specifying Message Options 

Formatting Text 

Inserting a Signature 

Attaching a File to a Message 

Receiving and Reading Email 

Replying to and Forwarding a Message 

Deleting a Message 

Organizing Messages 

Printing Messages 

Over the past decade, email (short for 

electronic mail) has become an accepted 

and even required form of business 

communication. And of course, many people 

use email to keep in touch with friends and 

family, either from work or from home. 

Outlook makes it easy to connect to multiple 

email accounts, either on a business network 

or over the Internet, and provides all the 

tools you need to send, respond to, organize, 

filter, sort, find, and otherwise manage 

email messages. 

Home Tab / New Email 
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The To and Cc address boxes are always displayed in the message header. The Bcc address box is 

not displayed by default. You can display it in the message header by clicking the Bcc button, 

located in the Show Fields group on the Options tab of the message composition window. 

You can insert an email address into an address box in the following ways: 

 

 

 

 

 

 

 

 

 

 

 Enter the entire address. 

 Enter part of a previously used address and then select the address from the Auto-Complete List 

that appears. 

 Click the address box label to display the Select Names dialog box, in which you can select one or 

more addresses from your address book(s). 

If you want to send the message to more than one person, insert a semicolon (;) between each 

e ipie t’s e-Mail address—for example, jhurley@mta.com; bralley@yahoo.com. 

KEYBOARD SHORTCUT Press Ctrl+K to initiate address resolution. For more information about keyboard 

sho t uts, see Ke oa d sho t uts  at the e d of this ook. 

4. Type the subject of the e-Mail in the Subject field. The Subject field lets your recipients know what 

the message is about. 

Enter a brief description of the message contents or purpose in this field. The subject is not required, but 

it is important to provide information in this field, both so that you and the recipient can identify the 

message and so that the message is t lo ked as suspe ted ju k ail  a e ipie t s e ail p og a . 
Outlook will warn you if you try to send a message with no subject. 

5. Click inside the body area of the message window and type your message. You can include many 

types of information, including formatted text, hyperlinks, and graphics in the message body. 

6. Click the Send button in the Message window. Your message is released into cyberspace and on 

its way to the specified recipient(s). 
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Troubleshooting the Auto-Complete List 

As you enter a name or an email address into the To, Cc, or Bcc box, Outlook displays matching addresses 

in a list. You can insert a name or address from the list into the address box by clicking it or by pressing 

the arrow keys to select it and then pressing Tab or Enter. 

Sometimes the Auto-Complete List might contain incorrect or outdated addresses—for example, if you 

have previously sent a message to an incorrect email address, or if a person changes his or her email 

address. The list might also contain people with whom you no longe  o espo d. If ou do t e o e 
i o e t o  outdated add esses f o  the list, it a  e eas  to istake l  a ept Outlook s suggestio  
and send a message to the wrong address.  

To clean up the Auto-Complete List: 

1. In the list, point to the name or address you want to remove. 

2. Click the Delete button (the X) that appears to the right of the name or address. 

You can modify the Auto-Complete List settings in the Send Messages section of the Mail page of the 

Outlook Options dialog box as follows: 

 To prevent the Auto-Complete List from appearing when you enter an address, clear the 

Use Auto-Co plete List to suggest a es… check box. 

 To remove all entries from the Auto-Complete List (and start the list from scratch) click the 

Empty Auto-Complete List button, and then click Yes in the dialog box that appears. 

 

Managing multiple accounts 

 

If you have configured Outlook to connect to multiple email accounts, you need to ensure that the 

message is being sent from the correct account. 

By default, Outlook assu es that ou i te d to se d a essage f o  the a ou t ou e u e tl  o ki g 
in. If you begin composing a message while viewing the Inbox of your work account, for example, Outlook 

selects the work account as the message-sending account. If you reply to a message received by your 

personal account, Outlook selects the personal account as the message-sending account. 

You can easily change the message-sending account. When Outlook is configured to use multiple 

accounts, a From button appears in the message header. 

 

If Outlook is configured to connect to only one account, you can display the From button by clicking 

From in the Show Fields group on the Options tab of a message composition window. Clicking the 

From button displays a list of active accounts from which you can choose.  

 Similar to 2013 

Similar to 2013 
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Specifying Message Options 

 

Outlook lets you specify options for your email messages. You can mark messages as urgent, specify a 

read receipt for all messages, or request that your messages be encoded so that they can only be read by 

the intended recipient(s).  

Set message priority 

If the intended recipient of a message receives a lot of email throughout the day, specify your message as 

important so that it will stand out in his or her Inbox. 

1. In the Message window, click the MESSAGE tab on the Ribbon. 

2. Click the High Importance or Low Importance button in the Tags group. 

 

High Importance: Inserts a red exclamation point next to the message subject. 

Low Importance: Inserts a blue, downward-pointing arrow next to the message subject. 

 

 

 

 

 

 

Request a Read or Delivery Receipt 

In Outlook 2013, you can request delivery and read receipts when you send a message. That way, you can 

track when a recipient receives and reads the message. 

Not Applicable 

Similar to 2013 
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Note: Read receipts only work if your recipie t s email program supports them. 

1. In the Message window, click the OPTIONS tab on the Ribbon. 

2. Select Request a Delivery Receipt and/or Request a Read Receipt in the Tracking group. 

 

 

 

 

 

 

 

Request a Delivery Receipt: Sends a notification when the message has been successfully delivered. 

Request a Read Receipt: Sends a notification when the recipient has opened the message. 

Do ’t el  too hea il  o  ead e eipts; the recipient has the option to deny returning a receipt. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Other Options 

You might have noticed a variety of other message options on the Ribbon or in the Properties dialog box. 

Other Ways to Request Receipts 

Click the OPTIONS tab on the 

Ribbon and click the Dialog Box 

Launcher in the Tracking group. 

Under Voting and Tracking 

options, select Request a delivery 

receipt for this message, Request 

a read receipt for this message, or 

both. Click Close he  ou’ e 

finished. 
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Importance Specifies whether the message is of high, normal, or low importance. 

Sensitivity Displays a tag indicating how the recipient should treat the message. 

Security Settings Encodes the message so it is not readable by anyone except the intended 

recipient(s). 

Use voting buttons Allo s the e ipie t to ui kl  a s e  a se de s uestio   use of oti g 
buttons. Outlook can then tabulate the results of the vote for the sender. 

Request a delivery 

receipt  

Returns a message to you verifying the date and time the message arrived at 

the Inbox of the recipient. 

Request a read receipt Returns a message to you verifying the date and time the message was 

opened by the recipient. 

Have replies sent to Sends all replies to the message to someone else, such as an assistant. 

Do not deliver before Waits to send the message until the date and time you specify. 

Expires after Makes the message unavailable after a specified date and time. 

Save sent message to Saves a copy of the sent message in the specified folder. 

 

 

Formatting Text 

 

Outlook can send and receive email messages in three message formats: 
Options Tab 
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 HTML: Supports paragraph styles (including numbered and bulleted lists), character styles (such 

as fonts, sizes, colors, weight), and backgrounds (such as colors and pictures). Most (but not all) email 

p og a s suppo t the HTML fo at. P og a s that do t suppo t HTML displa  these essages as Plai  
Text. 

 Rich Text: Supports more paragraph formatting options than HTML, including borders and shading, 

but is compatible only with Outlook and Exchange Server. Outlook converts Rich Text messages to HTML 

when sending them outside of an Exchange network. 

 Plain Text: Does not support the formatting features available in HTML and Rich Text messages but 

is supported by all email programs. 

You cannot format message text if your message format is set to Plain Text. To see which message 

format you are using, click the FORMAT TEXT tab on the Ribbon. 

 

 

 

 

 

 

E ail essage o te t is t li ited to si ple te t. You a  eate al ost a  t pe of o te t i  a  e ail 
message that you can in a Microsoft Word document. Because Outlook 2013 and Word 2013 share similar 

commands, you might already be familiar with processes for creating content such as lists and tables. 

You can personalize your messages by using an individual font style or color and by inserting your contact 

information in the form of an email signature or business card.  

 

 

 

 

 

 

 

 

 

 

 

Similar to 2013 
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Checking your Spelling 

It s a good idea to spell-check your messages before you send them. Not only do spelling errors make you 

look unprofessional, they also reflect poorly on your product or organization. 

By default, Outlook checks for spelling errors as you type, underlining misspelled words in red. This makes 

it easy to correct spelling errors individually. 

1. In the message window, right-click the misspelled word. A contextual menu appears, offering 

suggestions for the correct spelling of the word. 

2. Select the correct spelling of the word from the contextual menu. 

3. Outlook corrects the spelling of the word and the red underline disappears. 

 

Working with Hyperlinks 

A hyperlink is a dynamic word or icon that, when clicked, opens a specific file or location. You can create 

a hyperlink to a Web page, picture, document, and more. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. In the body area of the message, select the 

area where you want to insert the hyperlink. 

2. Right click on your selection and choose 

Hyperlink option. 

3. Type the Web address of the page you want 

to link to in the address area.  

4. Click OK. 

 

Options Tab 

Message Tab / Hyperlink 
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To Insert Email address hyperlink to your document 

1. Select text that you want to add email hyperlink.  

2. Right click on and choose Hyperlink. 

3. Go to E-mail Address tab. 

4. Insert E-mail address and Subject of your emails. 

5. Click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

Inserting a Signature 

 

A signature is boilerplate text or a file that can be attached to an email message. Your signature appears 

at the bottom of any new messages you compose and can include such things as: 

 Your name, title, and organization 

 Your phone and fax number 

 Your address 

 A link to your Web page 

 You  o ga izatio s issio  state e t, a itt  o e-liner, or your favorite quote. 

 

 

 

 

 

 

Message Tab / Signature 
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Create a signature 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The next time you create a new message, your signature will appear at the bottom of the message. 

 

Set signature defaults 

You can choose a default signature, you can choose which email account, as well automatically use it – 

for new messages, replies and forwards.  

1. “pe if  ho  ou a t to use the sig atu e i  the Choose default signature  se tio . Selecting 

different signatures for each one of these actions is possible. 

1. Create a new message. A new message window appears. 

2. Click the MESSAGE tab on the Ribbon. Click the Signature button in 

the Include group and select Signatures. The E-MAIL SIGNATURE 

tab of the Signatures and Stationery dialog box appears. 

3. Click the New button. The New Signature dialog box appears. 

4. Enter a name for the signature and click OK. Now create the 

signature as you want it to appear. 

5. Type the text that you want to appear in the signature in the Edit 

signature area. 

6. Click OK. 

 

Message Tab / Signature / Edit Signatures 
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2. Click OK.  

 

 

Insert a signature manually 

If you want to insert a diffe e t sig atu e, o  ou do t ha e a default sig atu e, ou a  also i se t 
signatures manually. 

 

 

 

 

 

 

 

 

 

Attaching a File to a Message 

 

A convenient way to distribute a file (such as a Microsoft PowerPoint presentation, Excel workbook, Word 

document, or picture) is by attaching the file to an email message. Message recipients can preview or 

open the file from the Reading Pane, open it from the message window, forward it to other people, or 

save it to their computers. 

1. In the Message window, click the MESSAGE tab on the Ribbon and click the Attach File button in 

the Include group. The Insert File dialog box appears. 

2. Navigate to and select the file you want to insert and click Insert. The selected file is attached to 

the message. 

 

1. Create a new message. A new message 

window appears. 

2. In the Message window, click the INSERT 

tab on the Ribbon. 

3. Click the Signature button in the Include 

group and select the signature you want to 

insert from the list. 

 

The signature is inserted into the message. 

Edit Signatures / Default Signature 
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Other Ways to Attach a File 

In the Message window, click the INSERT tab on the Ribbon and click the Attach File button in the Include 

group.  

 

 

 

 

 

 

Attach other items 

You can also attach other items to a new Mail message, such as another email, an appointment, or a 

conta t s Busi ess Ca d. 

1. In the Message window, click the MESSAGE tab on the Ribbon and click the Attach Item button in 

the Include group. 

A list of items appears, including: 

 Business Card: Select this option to include a Business Card from your Contact list. 

 Calendar: Select this option to include your free/busy information. 

 Outlook Item: Select this option to include an Outlook item, such as an e-Mail, appointment, or 

task. 

2. Select the type of item you want to attach and follow the prompts if necessary. 

 

 

 

 

 

Drag and drop contact, email, etc. 
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Receiving and Reading Email 

 

Each time you start Outlook and connect to your email server, any new messages received since the last 

time you connected appear in your Inbox. 

If ou do t a t to ait fo  Outlook to et ie e ou  essages, ou a  he k fo  messages manually. 

3. Click the MAIL button in the on the bottom Navigation Bar. The Inbox appears. 

4. Click the SEND/RECEIVE tab on the Ribbon and click the Send/Receive All Folders button in the Send 

& Receive group. Outlook checks all accounts for messages. Any new, unread messages appear in 

bold. 

 

When new messages, meeting requests, or task assignments arrive in your Inbox, Outlook alerts you in 

se e al a s so that ou a  e a a e of e ail a ti it  if ou a e usi g a othe  appli atio  o  if ou e 
been away from your computer. 

 A desktop ale t appea s o  ou  s ee  fo  a fe  se o ds, displa i g the se de s i fo atio , the 
message subject, and the first few words of the message. 

 

 

 

 

 

 

You can open the message from the desktop alert. 

 A chime sounds. 

 A New Mail Message icon appears on the Outlook taskbar button. 

 You can configure Outlook to briefly change the shape of the mouse pointer to an envelope. 

You can configure the individual notification options from the Mail page of the Outlook Options dialog 

box, Mail Options.  

Icons displayed in the message header indicate optional information such as: 

 The most recent response action taken. 

 Whether files are attached. 

 If it has been digitally signed or encrypted. 

 If the sender marked it as being of high or low importance. 

 

Home Tab / Send - Receive 
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Changing Views 

There are three standard views of the message list:  

 Compact This view displays two lines of message properties, including the read status, subject, 

sender, time received, whether files are attached to the message, and any color categories or follow-up 

flags associated with the message. This is the default view. 

 Single This one-line view displays the importance, reminder, item type or read status, whether files 

are attached to the message, sender, subject, received, size, category, and follow-up flags. The Reading 

Pane is open by default in this view. 

 Preview This view displays from one to four lines of information about each message. For every 

message, Preview view displays the same information as Single view. For each unread message, Preview 

view also displays a part of the message content—specifically, the first 255 characters (including spaces). 

If a message contains fewer than 255 characters, <end> appears in the preview text. The Reading Pane is 

closed by default in this view.  

Changing a view lets you control the amount of information you see when you open your Inbox. 

1. Click the Mail button in the Navigation Pane. The Inbox appears. 

2. Click the VIEW tab on the Ribbon and click the Change View button in the Current View group. 

3. Select a view from the list. The selected view is applied. 
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You can view the text of a message in several ways: 

 You can open a message in its own window by double-clicking its header in the message list. 

 You can read a message without opening it by clicking its header once in the message list to display 

the message in the Reading Pane. 

 You can display the first three lines of each unread message under the message header by using 

the Preview feature. Scanning the first three lines of a message frequently gives you enough 

information to make basic decisions about how to manage it. The only drawback is that in Preview 

view, each unread message takes up five lines rather than the two lines in the default Messages 

view, so fewer messages are visible on your screen at one time. 

 

Opening an Attachment 

Whenever you see a paper clip icon next to a message, the message contains an attachment. 

Never open an unfamiliar or suspicious attachment. Install a good anti-virus program on your 

computer and save files to your computer before opening them. 

You can view message attachments in several ways: 

 You can preview certain types of attachments (including Word documents, Excel workbooks, 

PowerPoint presentations, and PDF files) directly in the Reading Pane by clicking the attachment 

(one time) in the message header. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 You can open the attachment in the program assigned to that file type from the Reading Pane or 

from an open message window by double-clicking the attachment in the message header. 

When you click the attachment, the 

message text is replaced by a preview 

of the attachment contents, and the 

Attachments tool tab appears on the 

ribbon. To redisplay the message 

content, click the Message button that 

appears to the left of the attachments 

in the message header. 

 

Open Email / Preview Option 
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 You can save the attachment to your hard disk and open it from there. This strategy is 

recommended if you suspect an attachment might contain a virus, because you can scan the file 

for viruses before opening it (provided that you have a virus scanning program installed). 

 

 

1. Right-click the attachment in the Reading pane. 

2. Select Save As or Save All Attachments from the contextual menu. 

 

If you receive a contact record or business card as a message attachment, you can add it to your 

primary address book by dragging the attachment from the email message to the Contacts link or 

button on the Navigation Bar.  

 

Replying to and Forwarding a Message 

 

Reply to a message 

Replying to an email is like answering a letter; it acknowledges that you received the message and allows 

you to respond. 

1. Click the MAIL button in the bottom Navigation Bar. The Inbox appears. 

2. Double-click the message to which you want to reply. The message opens in its own window. 

3. Click the MESSAGE tab on the Ribbon and click the Reply or Reply All button in the Respond group. 

 Reply: Sends your reply to the author of the message only. 

 Reply All: Sends your reply to the author of the message and everyone else who received the 

message. 

4. Type your reply and click the Send button. 

 

Forward a message 

Forwarding a message sends the message on to someone else instead of back to the original sender. 

1. Click the MAIL button in the bottom Navigation Bar. The Inbox appears. 

2. Double-click the message that you want to forward. 

3. The message opens in its own window. 

4. Click the MESSAGE tab on the Ribbon and click the Forward button in the Respond group. 

5. In the To field, enter the e-Mail address(es) of the person(s) to whom you want to forward the 

message. 

6. Type any comments you wish to add to the message and click the Send button. 

 

NOTE: All atta h e ts a d essage optio s, su h as High I po ta e  tags, a e i luded he  ou 
forward a message. 
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Forward As Attachment  

Creates a blank message that contains no text but includes the original message as an attachment. The 

original message text and any attachments are available to the new recipient when he or she opens the 

attached message. 

 

Deleting a Message 

 

Whe  ou e fi ished ith a essage, it s a good idea to delete it. Deleti g essages as soo  as ou e 
done with them keeps your Inbox organized and free from clutter. 

Delete a message 

1. Click the Mail button in the Navigation Bar and select the message you want to delete. 

2. Press the <Delete> key. The message is removed from your Inbox and placed in the Deleted Items 

folder. 

 

Retrieve a message 

Just like the Windows Recycle Bin, you can retrieve an item if you accidentally delete it. 

1. Open Outlook.  

2. Click on the Folder tab.  

3. Select Recover Deleted Items. 

 

 

 

 

 

 

4. Click the message you want to recover, and then check Restore Selected Items. 

5. Click OK. 

 

To select multiple items, press Ctrl as you click each item, and then click Recover Selected Items. 

Recovered items are restored to the folder you're working in. 

Items can only be recovered within 30 days of when they were emptied from within "Deleted 

Items" folder. After this time elapses, items cannot be restored. Also, if items are purged from 

"Deleted Items" folder, they can no longer be recovered. 

Message / Attachment 

Not Applicable / Workaround: OWA 
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If a folder is deleted, it cannot be restored. Only messages can be restored (the folder structure 

cannot be restored). All messages will be restored to your inbox regardless of which folder they 

were deleted from. 

Items within the recover utility will only show the message headers. The full message will be 

available after the message has been recovered. 

 

Organizing Messages 

 

Outlook 2013 automatically handles certain types of organization for you. You can organize items in 

Outlook by storing related items in folders and by assigning color categories to related items of all types. 

Outlook makes it easy to follow related messages from multiple people by displaying the messages in 

Conversation view. With Outlook Search, you can quickly locate items that contain specific content or 

meet specific criteria; you can save search results as Search Folders in which you can view up-to-date 

search results at any time. 

 

Flagging a Message for Follow-up 

 

Flagging a message is an easy way to remind yourself to follow up on an important e-Mail or task. When 

you flag an item, a small icon appears next to the message, and a copy of the message is added to your 

To-Do List. 

Flagging a message is extremely easy. 

1. Click the Mail button in the Navigation Bar. The Inbox appears 

2. Click the Flag area of the message you want to flag. The default flag—the Today flag—is applied 

to the message, and a copy of the message is added to your To-Do List. 

 

Change flags 

The default flag is the Today flag, but there are several others flags from which to choose. 

1. Click the message containing the flag you wish to change. You can also right-click the flag you 

wish to change and select a new flag from the contextual menu. 

2. Click the HOME tab on the Ribbon and click the Follow Up button in the Tags group. A list of 

flags appears. 

3. Select a flag from the list. 

Similar to 2013 
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Description of the flags: 

Flag Start date Due Date 

Today Current Date Current Date 

Tomorrow Current date plus one day Current date plus one day 

This Week Current date plus two days, but no later than the last 

work day of this week 

Last work day of this week 

Next Week First work day of next week Last work day of next week 

No Date No date No date 

Custom Current date is displayed; choose a custom date if 

desired 

Current date is displayed; choose a 

custom date if desired 

 

Remove a flag 

O e ou e follo ed-up on a flagged message, ou a  e o e the flag o  a k it as Co plete . 

1. Right-click the flag you want to remove. 

2. Select Mark Complete or Clear Flag from the contextual menu. 

 

Using Color Categories 

 

Color categories let you organize your Outlook items into specific groups, making the information they 

contain easier to distinguish. You can choose from a set of default categories, or you can create your own. 

Assign a color category 

1. Click the Mail button in the Navigation Bar. The Inbox appears. 

Similar to 2013 
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2. Select the message you wish to categorize 

3. Click the HOME tab on the Ribbon and click the Categorize button in the Tags group. A list of 

categories appears. 

4. Select a category from the list. The selected category is applied to the message. 

You can assign multiple categories to a message. 

Rename a category 

Outlook i ludes se e al olo  atego ies su h as the ‘ed Catego  o  Blue Catego .  You a  e a e 
these categories to meet your needs. 

1. Click the Mail button in the Navigation Bar. The Inbox appears. 

2. Click the HOME tab on the Ribbon and click the Categorize button in the Tags group. A list of 

options appears. 
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3. Select All Categories from the list. The Color Categories dialog box appears. 

4. Click the color category you wish to rename and click Rename. The color category name 

becomes editable. 

5. Type a new name for the category and click OK he  ou e fi ished. The category is renamed. 

 

Create a new category 

Outlook may contain default categories, but you can create your own to better meet your needs. 

1. Select All Categories from the list. The Color Categories dialog box appears. 

2. Click New. The Add New Category dialog box appears. Here you can name the category, assign 

a new color, or create a keystroke shortcut. 

3. Set the properties of the new category and click OK. The new category is added to the list of 

categories. 

 

 

 

 

 

 

Clear a category 

If ou de ide ou do t a t to atego ize a essage afte  all, ou a  lea  the atego . 

Right-click the message from which you wish to clear categories and select Clear All Categories. 

 

Viewing Conversations 

 

Conversation view is an alternative arrangement of messages grouped by subject. All the messages with 

the same subject appear together in your Inbox (or other message folder) under one conversation header. 

The conversation header provides information about the messages within the conversation, including the 

number of unread messages and whether one or more messages includes an attachment, is categorized, 

or is flagged for follow up. 

 When you receive a message that is part of a conversation, the entire conversation moves to the 

top of your Inbox and the new message appears when you click the conversation header. 

 When a conversation includes unread messages, a blue vertical line appears to the left of the 

header and the conversation subject is in bold blue font, just as an unread message would appear.  

 When you have multiple unread messages, the number is indicated in parentheses following the 

subject. The senders of the unread messages are listed below the subject. 
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Turn on Conversation View 

When Conversation View is enabled, Outlook groups messages with the same subject into conversations. 

1. Click the Mail button in the Navigation Bar. The Inbox appears. 

2. Click the VIEW tab on the Ribbon and click the Show as Conversations check box in the 

Conversations group. The Microsoft Outlook dialog box appears. You can apply Conversation View 

to the currently selected folder or to all folders. 

3. Select the folder where you want to apply Conversation View.  Conversation View is applied. 

Conversations are grouped by subject. If any message recipient changes the subject of a 

message, then that message becomes a new conversation. 

If the Show Conversations check box is inactive, make sure that you have sorted your messages 

by Date (Conversation). 

 

Change Conversation Settings 

Cha gi g Outlook s Co e satio  setti gs ha ges ho  Co e satio s a e displa ed. 

1. Click the Mail button in the Navigation Bar. The Inbox appears. 

2. Click the VIEW tab on the Ribbon and click the Conversations Settings button in the Messages 

group. A list of options appears: 

 

Managing Conversations 

Co e satio s a  lutte  ou  I o . You a  keep ou  I o  tid   ig o i g o e satio s ou do t 
want to read or by cleaning up a conversation. 

 Ignore Conversation. This command moves the selected conversation and any related messages 

you receive in the future directly to the Deleted Items folder. 

 Clean Up Conversation. This command deletes redundant messages—messages whose text is 

wholly contained within later messages—from a conversation. By default, Outlook does t lea  
up categorized, flagged, or digitally signed messages. You can modify conversation clean-up 

settings on the Mail page of the Outlook Options dialog box. 

 

1. Click the Mail button in the Navigation Bar. The Inbox appears. 

2. Click the conversation you wish to ignore / clean up. 

3. Click the HOME tab on the Ribbon and click the Ignore / Clean up button in the Delete group. 

 

 

 

 

 

Organize Tab / Conversations 
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Sorting Messages 

 

When your Inbox is jam-packed with messages, it can be difficult to find anything. When this happens, try 

so ti g ou  essages usi g Outlook s a a ge e t optio s. You a  so t ou  essages  the date the  
were sent, who sent them, and other attributes. 

1. Click the Mail button in the Navigation Bar. The Inbox appears. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Troubleshooting Conversation View 

As with many features, Conversation view has its fans and its detractors. Because Conversation view displays only 

u i ue essages u til ou full  e pa d the o e satio , a spe ifi  essage that ou e looki g fo  ight ot e 

immediately visible. If this happens, you can turn off Conversation view (by clearing the Show In Conversations check 

box in the Conversation group on the View tab) and then use one of the following methods to locate the message you 

want to find: 

 Sort the messages by subject, and then type the first few letters of the message subject to scroll those 

messages to the top of the message list. 

 Enter the subject into the Search box at the top of the message list and then specify any other criteria 

su h as the se de  o  date  of the essage that ou e looki g fo  to narrow the results. 

Organize Tab / Arrange By 
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2. Click the VIEW tab on the Ribbon and select an arrangement from the Arrangement group. 

Alternatively, you can click the current arrangement in the message list header, and then click the 

arrangement or option you want. 

By default, Outlook displays messages arranged by date, from newest to oldest. Alternatively, you can 

arrange items by any of the following attributes: 

 Account. Messages are grouped by the email account to which they were sent. This is useful if you 

receive messages for more than one email account in your Inbox. 

 Attachments. Messages are grouped by whether they have attachments and secondarily by date 

received. 

 Categories. Messages are arranged by the category you assign them to. Messages without a 

category appear first. Messages assigned to multiple categories appear in each of those category groups. 

 Flag: Start Date or Due Date. Unflagged messages and messages without specific schedules appear 

fi st. Messages that ou e added to ou  task list ith spe ifi  sta t o  due dates a e g ouped  date. 

 From. Messages appea  i  alpha eti al o de   the essage se de s displa  a e. If ou e ei e 
messages from a person who uses two different email accounts, or who sends messages from two 

different email clients (for example, from Outlook and from Windows Mail), the messages will not 

necessarily be grouped together. 

 Importance. Messages are grouped by priority: High (indicated by a red exclamation point), Normal 

(the default), or Low (indicated by a blue downward-pointing arrow). 

 To. Messages are grouped alphabetically by the primary recipients (the addresses or names on the 

To line). The group name exactly reflects the order in which addresses appear on the To line.  

 Size. Messages are grouped by size of the message, including any attachments. Groups include 

Huge (1–5 MB), Very Large (500 KB–1 MB), Large (100–500 KB), Medium (25–100 KB), Small (10–25 KB), 

and Tiny (less than 10 KB). This feature is useful if you work for an organization that limits the size of your 

Inbox, because you can easily locate large messages and delete them or move them to a personal folder. 

 Subject. Messages are arranged alphabetically by their subjects and then by date. This is similar to 

a a gi g  o e satio  e ept that the essages a e t th eaded. 

 Type. Items in your Inbox (or other folder) are grouped by the type of item—for example, 

messages, encrypted messages, message receipts, meeting requests and meeting request responses, 

tasks, Microsoft InfoPath forms, and server notifications.  

After arranging the items in your message list, you can change the sort order of the arrangement by 

clicking the sort order indicator that appears to the right of the message list header. 

Each group has a header. You can expand or collapse an individual group by clicking the arrow to the left 

of the group name in the header. 
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Regardless of the view and arrangement you choose, you can sort messages by any visible column simply 

by clicking its column heading (and reverse the sort order by clicking the column heading a second time). 

 

Organizing Messages in Folders 

 

To keep your Inbox content low and avoid an accumulation of unrelated messages, you can organize 

messages into folders. When you create a folder by clicking the New Folder button on the Folder tab of 

any module, you specify the location of the folder within your existing Outlook folder structure and the 

type of items you want the folder to contain. 

You can move messages to folders manually, or if your organization is running Exchange, you can have 

the email system move them for you. You can automatically move messages to another folder by creating 

a rule—for example, you can automatically move all messages received from your manager to a separate 

folde . You a  also set up diffe e t ules that go i to effe t he  ou e a a  f om the office. 

Quickly locating messages 

You can use the Search feature to locate specific terms in any Outlook item. Although you can search for 

items in the Calendar, People, Tasks, and Notes modules, you most often use it to locate messages in your 

Inbox and other mail folders.  

The Search feature can locate search terms in a message or in a file attached to a message. As you enter 

a search term in the Search box located at the top of the content area in any module, Outlook filters the 

items to show only those items in the module that contain the search term and highlights the search term 

in the list of results. 

Outlook fi st displa s up to 30 e e t esults.  Cli ki g the More link at the bottom of the list or the 

Include Older Results button in the Results group on the Search tool tab displays additional results within 

the selected search scope. 

Search Bar (upper-right corner) / Search Tab 
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The Search tool tab appears when you activate the Search box in any Outlook module. You can enter 

search terms into the Search box and refine your search by using the commands on the Search tool tab. 

 

Using Search Folders 

A Search Folder displays all the messages in your mailbox that match a specific set of search criteria, no 

matter which folders the messages are actually stored in. When you create a Search Folder, it becomes 

part of your mailbox and is kept up to date. The Search Folder module is located in the Folder Pane, within 

your top-level mailbox, at the same level as the Inbox. 

If you want quick access to messages that fit a specific set of criteria, you can create a custom Search 

Folder. To do so, follow these steps: 

1. Display any mail folder. 
Smart Folders 
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2. On the Folder tab, in the New group, click New Search Folder to open the New Search Folder dialog 

box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Printing Messages  

 

Sometimes it can be refreshing to read a message in hard copy, especially if the message is long. Printing 

a message in Outlook is extremely easy. 

1. Click the Mail button in the Navigation Bar. The Inbox appears.  

2. Select the message you want to print.  

3. Click the FILE tab and select Print.  

4. Click the Print Options button. 

Search Folder categories include 

Reading Mail, Mail from People and 

Lists, Organizing Mail, and Custom. 

File Menu / Print 
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If necessary, you can adjust the following settings: 

 Printer Select an installed printer or add a new one. 

 Print Options Change the default printing options in the Print dialog box before printing. You can 

also change an existing print style (the way the message is presented on the printed page) or create a new 

one. 

 Settings Choose from the existing print styles available for the selected message or other Outlook 

item. The default print style is Memo style, which prints your name, the message header information, and 

then the message content. 

5. Click Print to begin printing. 
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Working with Contacts 
 

 

 

 

 

 

 

 

 

 

 

 

Address Books 

 

The Address Book can get its information from one or more sources, including Internet directory services 

and third party address books. Here are the two most common sources that the Address Book uses: 

Global Address List If you use Outlook in a networked environment, the Global Address List contains your 

organizatio s use s, g oups, a d o ta t g oups. The Glo al Add ess List is si ila  to a la ge telepho e 
directory that is available for everyone to use. A network administrator usually manages the Global 

Add ess List, so ou a t ake a  ha ges to it. 

Outlook Address Book The Contacts address book of your default email account is your main address book, 

and it is the address book that appears by default in the People module. The Contacts address book is 

empty until you add contact records to it. 

 

 

 

 

 

 

Open the Address Book 

It does t atte  if ou e o ki g ith e-Mail or the calendar—you can always find the Address Book. 

IN THIS CHAPTER 

Address Books 

Adding a Contact 

Editing and Deleting a Contact 

Viewing and Sorting Contacts 

Adding a Contacts Folder 

Creating a Contact Group 

Printing Contact Records 

Having immediate access to current, accurate contact 

information for the people you need to interact with—by 

email, phone, mail, or otherwise—is important for timely 

and effective communication. You can easily build and 

maintain a detailed contact list, or address book, in the 

Microsoft Outlook 2013 People module. From your 

address book, you can look up information, create 

messages, and share contact information with other 

people. You can also keep track of your interactions with 

a person whose contact information is stored in Outlook. 

Home Tab / Contact Search 
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1. Click the HOME tab on the Ribbon and click the Address Book button in the Find group. The Address 

Book appears. By default, names from your organization are displayed from the Global Address 

List. 

2. Click the Close button. The Address Book closes.  
 

 

 

 

 

Adding a Contact 

 

The Contacts list contains information about people and organizations with whom you interact. You can 

enter as much or as little information about your contacts as you want in the Contacts list, including 

names, phone numbers, e-Mail accounts, and addresses. 

You can use the Contacts list with other Outlook tools. For example, you can schedule an appointment 

with or send an e-Mail to a contact. You can even use the Contacts list with other programs, such as 

software for an electronic organizer.  

1. Click the People button in the Navigation Bar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

By default, the Contacts list appears in Business Cards view. In this view, your contacts are displayed as Electronic 

Business Cards, which look like actual paper business cards on the screen. 

2016 Similar to 2013 
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2. Click the HOME tab on the Ribbon and click the New Contact button in the New group. The Untitled 

Contact window appears. You can enter the co ta t s a e, o pa , jo  title, e-Mail address, 

Web page address, phone numbers, and/or addresses. 

 

 

 

 

 

 

3. Enter as much contact information as you want in the window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you create a contact with the same name as another contact, the Duplicate Contact Detected 

dialog box appears. Here, you can add a new record if the contact is a new contact or update the 

o ta t’s e isti g e o d. 

Several of the fields in the Contact window have buttons and list arrows next to them. The buttons 

display dialog boxes to assist you with the fields, while the arrows are used if a contact has 

multiple phone numbers, e-Mail accounts, or addresses. 
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4. Click the CONTACT tab on the Ribbon and click the Save & Close button in the Actions group. The 

Contact window closes and the new contact appears in the Contacts list. 

 

Adding a Contact from an E-Mail 

You can add someone to your Contacts list using an e-Mail ou e e ei ed. To add a  e-Mail se de s 
name and e-Mail address to your Contacts list, simply drag the e-Mail to the People button in the 

Na igatio  Ba . Outlook ill add the se de s a e a d e-Mail address to the Contacts list—and you can 

add any additional information yourself. 

1. Click the Mail button in the Navigation Bar. The Inbox appears. 

2. Click and drag the e-Mail to the People button in the Navigation Bar. The Contact window opens, 

a d the pe so s a e a d e-Mail address are filled in automatically. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Enter any additional information for the contact. 

4. Click the CONTACT tab on the Ribbon and click the Save & Close button in the Actions group. 

 

Editing and Deleting a Contact 

 

It s eas  to ie  a d ha ge i fo atio  a out ou  o ta ts. You a  edit o ta t i fo atio   dou le-

clicking a contact to open it in the Contact window, or you can edit information about a contact directly 

in the Contacts list. The latter method is more efficient; simply select the entry you wish to edit and make 

your changes. 

Not Applicable 
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Edit a contact 

1. Click the People button in the Navigation Bar. Outlook displays the Contacts list. 

2. Double- li k the o ta t ou a t to edit i  the Co ta ts list. That pe so s o ta t i do  
appears. 

3. Make the necessary changes. 

4. Click Save. The i do  loses a d the ha ges to the o ta t s i fo atio  a e sa ed. 
 

Delete a contact 

You can also delete contacts if you no longer need them. 

1. Double- li k the o ta t ou a t to delete i  the Co ta ts list. That pe so s o ta t i do  
appears. 

2. Click the CONTACT tab on the Ribbon and click the Delete button in the Delete group. The contact 

is moved to the Trash folder in your Mailbox. 

 

Viewing and Sorting Contacts 

 

Like other folders in Outlook, the Contacts list has several different ways to look at the same information. 

These different views are very useful when it comes to organizing the Contacts list. 

 

Change Contacts list view 

By default, contacts appear in Outlook in People view. In this view, your contacts are displayed as an 

alphabetical list. 

Changing the Contacts view changes how much information is displayed about your contacts in the 

Contacts list. You can display more detailed information about each contact, such as with the Business 

Cards or Cards view. Or, you can display more contacts on the screen at once, such as with the Phone or 

List view. 

1. Click the People button in the Navigation Bar. 

Outlook displays the Contacts list. 

2. Click the HOME tab on the Ribbon. 

3. Select the view you want to use from the Current 

View group. The new view is applied. 

 

 

 

 

 

Not Applicable 
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Each view presents information from your contact records either as cards or in a list: 

 People Displays only contact names in the contact list, and the available information for the 

selected contact in the Reading Pane. Contact names are displayed in alphabetical order by first or last 

name, depending on the File As selection. This view displays information about the contact from multiple 

sources. For example, if you have an Outlook contact record for a person you network with on LinkedIn 

and Facebook, the People card displays a compilation of the information from all three locations. This 

view, which is new in Outlook 2013, is the default view.  

 Business Card Displays the business card associated with each contact record—either the default 

card created by Outlook or a custom card if you have one. Business cards are displayed in the alphabetical 

order specified by the File As selection. 

 Card Displays contact information as truncated business cards that include limited information, 

such as job title and company name. 

 Phone Displa s a olu a  list that i ludes ea h o ta t s a e, o pa , a d o ta t umbers. 

You can choose the grouping you want from the Arrangements gallery on the View tab. 

List Displays a columnar list with contact records arranged in groups. You can choose the grouping 

you want from the Arrangements gallery on the View tab. 

In any list view, you can expand and collapse the groups or select and take action on an entire group of 

contacts. You can also enter information directly into any contact record field displayed in the list. 

 

Sort contacts 

If you are working in Phone or List view, you can further sort your contacts by categories, company, or 

location. 

1. Click the People button in the Navigation Bar. Outlook displays the Contacts list. 

2. Click the VIEW tab on the Ribbon. There are three options for sorting your contacts: 

 

 Categories: Organizes and sorts contacts by color category (if categories have been assigned to 

contacts). 

 Company: Organizes and sorts contacts by company (if a company has been assigned to contacts). 

 Location: Organizes and sorts contacts by location (if a location has been assigned to contacts). 

 

3. Select an arrangement from the Arrangement group. 

 

Finding and Organizing Contacts 

There are several ways to search for information in your contacts. 

1. Click the People button in the Navigation Bar. The Contacts list appears. To find a contact or 

contact information, choose from the following search methods: 

 

Arrange By 
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 Search address books: Click the HOME ta  o  the ‘i o , e te  a o ta t s a e o  o pa  
name in the Search address books box in the Find group, and press <Enter>. 

 Instant Search (Search Contacts): Just as you can search e-Mail messages using keywords, you can 

also search contacts. Enter search keywords (or even a phone number) in the Search Contacts box 

at the top of the Contacts list. 

 Alphabetical index: If you are viewing your contacts in Business Cards or Cards view, click a letter 

button in the index that appears by the cards to display contacts beginning with that letter. 

 Sort table: If you are viewing your contacts in a table view such as Phone view, click a column 

headi g to so t the o ta ts  that olu s ite ia. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Select a search method and complete your search. 

 

Adding a Contacts Folder 

 

You can organize your contacts by creating folders for specific categories of contacts. 

1. Click the People button in the Navigation Bar. The Contacts list appears. 

Alphabetical index 

Search Address Book 

Search Contacts 
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2. Click the FOLDER tab on the Ribbon and click the New Folder button in the New group. 

3. E te  a a e fo  the e  folde  a d ake su e Co ta t Ite s is sele ted u de  the Folde  
o tai s  list a o .  

4. Click OK. The new folder appears in the Navigation Pane under My Contacts. Now you can move 

contacts into the new folder. 

Click and drag a contact from the Contacts list to the e  folde s i o  i  the Na igatio  Pa e. The contact 

is moved to the new folder. 

 

 

 

 

 

 

 

 

 

 

 

You can also organize contacts by assigning them to color categories. Right-click a contact in the 

Contacts list, point to Categorize, and select a category. 
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Creating a Contact Group 

 

A contact group, known in previous versions of Outlook as a distribution list, lets you group e-Mail 

addresses together. A contact group can save you time when you have to send e-Mail to: 

 All employees in the same department or organization. 

 Colleagues on the same project or committee. 

 A group of friends. 

Co ta t g oups appea  i  ou  Co ta ts list the sa e a  that a pe so s a e does. To add ess a  e-

Mail message using a contact group, follow the same steps that you would with any other message. 

Before you can send e-Mails to recipients in a contact group, you need to create the group. 

1. Click the People button in the Navigation Bar. The Contacts list appears. 

2. Click the HOME tab on the Ribbon and click the New Contact Group button in the New group. The 

Untitled–Contact Group window appears. 

 

 

 

 

 

 

 

 

 

3. Enter a name for the contact group in the Name text box. For example, you could name the contact 

g oup Fa il  o  Ma age e t Tea . No  ou e ead  to hoose hi h e ipie ts ou a t 
to include in the contact group 

4. Click the CONTACT GROUP tab on the Ribbon and click the Add Members button in the Members 

group.  

 

There are three sources you can use to add recipients to a contact group: 

 From Outlook Contacts: Use this option to add a recipient already in your Outlook Contacts list. 

 From Address Book: Use this option to add a recipient from the Address Book, including any 

recipients in the Global Address List. 

 New E-Mail Contact: Use this option to add a recipient who has not been entered as an e-Mail 

contact. 

5. Select an option from the list. Depending on the option you select, either the Select Members or 

Add New Member dialog box appears. 

6. Select or enter the recipients you wish to add. 

7. Click the Save & Close button in the Actions group on the Ribbon. 

 

 

Home Tab / New Contact Group 
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Printing Contact Records 

 

Depending on the view, Outlook offers a variety of print styles, such as those described in the following 

table. 

 

Style Description Available in these 

views 

Card Contact information displayed alphabetically in two columns. Letter 

graphics appear at the top of each page and the beginning of each letter 

group. 

Business Card, 

Card, People 

Small Booklet Contact information displayed alphabetically in one column. Formatted 

to print eight numbered pages per sheet. Letter graphics appear at the 

top of each page and the beginning of each letter group, and a contact 

i de  at the side of ea h page i di ates the positio  of that page s 
entries in the alphabet. 

Business Card, 

Card, People 

Medium 

Booklet 

Contact information displayed alphabetically in one column. Formatted 

to print four numbered pages per sheet. Letter graphics appear at the 

top of each page and the beginning of each letter group, and a contact 

i de  at the side of ea h page i di ates the positio  of that page s 
entries in the alphabet.  

Business Card, 

Card, People 

Memo Contact information displayed under a memo-like header that contains 

your name. One record per sheet. 

Business Card, 

Card, People 

Phone Directory Contact names and phone numbers displayed in two columns. Letter 

graphics appear at the top of each page and the beginning of each letter 

group. 

Business Card, 

Card, People 

Table Contact information displayed in a table that matches the on-screen 

layout. 

Phone, List 

 

File Menu / Print 
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Using the Calendar 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Scheduling an Appointment 

 

Appointments are blocks of time you schedule for only yourself (as opposed to meetings, to which you 

invite other Outlook users). An appointment is any scheduled activity that takes place within a one-day 

time period, and has a specific start time and end time (as opposed to an event, which occurs for one or 

more full 24-hour periods). 

1. Click the Calendar button in the Navigation Bar.  

2. Click the New Appointment button on the Ribbon. 

You can use the Microsoft Outlook 

2013 calendar to organize your daily 

activities and to remind you of 

important tasks and events. Using the 

calendar effectively can help you stay 

organized, on time, and on task. You 

can schedule and track appointments, 

meetings, and events, and block time 

as a reminder to yourself to take care 

of tasks. You can also share your 

calendar information with other 

people in several ways; for example, 

you can share an entire calendar or 

only selected information with people 

inside or outside of your organization. 

IN THIS CHAPTER 

Scheduling an Appointment 

Scheduling a Meeting 

Working with Recurring Appointments 

Color-coding Appointments  

Responding to Meeting Request 

Updating and Cancelling a Meeting 

Viewing the Calendar 

Sharing Calendar Information 

Che ki g Othe  People s Cale da  

Printing a Calendar 

Defining Your Available Time 

Setting Out of Office Message 

Similar to 2013 
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3. Type a description of the appointment in the Subject field. 

4. Specify the date of the appointment and its start and end time. 

When creating an appointment, you indicate your availability (referred to as Free/Busy time) by marking 

it as Free, Working Elsewhere, Tentative, Busy, or Out Of Office. The appointment time is color-coded on 

your calendar to match the availability you indicate. Your availability is visible to other Outlook users on 

your network, and is also displayed when you share your calendar or send calendar information to other 

people. 

5. Enter additional information about the appointment as desired. 

6. Click the Save & Close button in the Actions group on the Ribbon. The Appointment window closes 

and the appointment appears in your calendar. 

 

Scheduling a Meeting 

 

When you schedule a meeting, the Calendar blocks off the specified time span—for example, from 10 

a.m. to noon. 

1. Click the Calendar button in the Navigation Bar. 

2. Click the New Meeting button on the Ribbon. An Untitled—Meeting window appears. 

 

 

 

 

 

 

3. Fill in the necessary information for the meeting you want to set up. 

To… - Attendee to be invited to the meeting.  

Subject - Subject title for the appointment. 

Location - Type the location of where the meeting will occur. 

Similar to 2013 
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Start time - Select the date and start time of the appointment. 

End time - Select the date and end time of the appointment. 

Description box - Type in any description or details of the appointment for your own reference. 

Show As – Change how the time for this event is marked on your calendar. 

Reminder - Select the desired reminder time to the right of the bell icon in the top middle of the 

Appointment window.  

You can also attach files such as Word documents, PDFs, spreadsheets and more to the meeting. 

These can be saved and/or opened by the other Attendees. Either drag a file from your computer 

into the body of the Appointment, or select Insert tab, then the Attach File icon from the top row 

of the Appointment window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Select the Scheduling Assistant icon near the top of the Meeting tab and review the chart that 

appears to the right of each individual's name.  

 

 

Blue: The time is marked as busy. 

Blue and White Striped: This time is scheduled with tentative appointments. 

Purple: This time is marked as out of office. 

Black and White Striped: Outlook has no information for this time. 
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5. Click Appointment in the Meeting tab at the top of the screen. This will return you to the 

Appointment screen. You will see the details for the date and time you selected. 

6. Click Send once you have completed the necessary details and you have now successfully sent out 

a meeting invitation and created a meeting. There should now be an entry for the meeting in your 

calendar. 

Organizer: This is the creator of the meeting; it will by 

default appear to the left of your name (and will not be 

an option for other attendees). This position is regarded 

as necessary by the Suggested Times list 

Required Attendee: Invitees to be regarded as 

necessary by the Suggested Times list. Invitees are by 

default listed as required. 

Optional Attendee: Invitees for whom attendance is 

optional; separated from Required Attendees in the 

Suggested Times list. 

Resource: This label marks rooms or equipment added 

to the meeting, and is regarded as necessary by the 

Suggested Times list 

 To change the desired meeting time simply 

slide the sides of the blue vertical bracket 

indicating your meeting's start and end 

times to a different place in the chart. Use 

the scroll bar at the very bottom of the 

chart to view more times and dates if 

needed. 

 

 To classify attendees, click the icon next to 

the attendee's name until you see the icon 

for the desired classification. Attendee 

classifications are taken into account by the 

Suggested Times. 
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Working with Recurring Appointments 

 

A recurring appointment is an appointment that occurs at regular intervals; for example, every Friday at 

10 a.m. 

Create a recurring appointment 

1. Click the New Items button in the New group on the Ribbon and select New Appointment from the 

drop-down.  

2. Type a description of the appointment in the Subject field. 

3. Click the Recurrence button in the Options group. 

 

 

 

 

 

 

 

4. The Appointment Recurrence dialog box appears. Here you need to specify the time of the 

appointment, how often the appointment should recur (for example, every Friday), and the start 

and end date of the recurrence. 

 

 

 

 

 

 

 

 

 

 

 

 

5. Make your specifications in the Appointment Recurrence dialog box and click OK. 

6. Click the Save & Close button in the Actions group. 

 

 

Similar to 2013 
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Edit a recurring appointment 

1. Double-click the appointment you want to edit. The Open Recurring Item dialog box appears. You 

have two options here: 

 Open this occurrence: Edits only the selected occurrence of the recurring appointment. 

 Open the series: Edits every occurrence of the recurring appointment. 

2. Select the appropriate option and click OK. The appointment opens in its own window. 

3. Edit the appointment as necessary. 

4. Click the Save & Close button in the Actions group. Outlook saves your changes. 

 

Delete a recurring appointment 

1. In the Calendar, click the appointment that you want to delete. 

2. Press the <Delete> key. The Confirm Delete dialog box appears. You have two options here: 

 Delete this occurrence: Deletes only the selected occurrence of the recurring appointment.  

 Delete the series: Deletes every occurrence of the recurring appointment. 

3. Select the appropriate option and click OK. 

 

Color-coding Appointments 

 

Color categories let you organize your Outlook items by color, making it easier to distinguish between 

different types of information. In the Calendar, you can color-code your appointments, meetings, and 

events. 

By default, six color categories are available. 

You can apply one or more categories to an 

item at a time. 

 

1. Select the appointment, meeting, or 

event you want to color-code. 

2. Right-click the item you want to color-

code, point to Categorize in the 

contextual menu. 

3. Select a color category from the list. 

4. The selected color is applied to the 

appointment. 

 

 

 

 

 

Similar to 2013 
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Responding to Meeting Request 

 

1. Open the meeting request or notification in your Inbox (rather than in your Calendar). 

2. You can respond to a meeting request in one of these four ways: 

 

Accept the request. Outlook deletes the meeting request and adds the meeting to your calendar. 

Tentatively accept the request, which indicates that you might be able to attend the meeting but are 

undecided. Outlook deletes the meeting request and shows the meeting on your calendar as 

tentatively scheduled. 

Propose a new meeting time. Outlook sends your request to the meeting organizer for confirmation 

and shows the meeting with the original time on your calendar as tentatively scheduled. 

Decline the request. Outlook deletes the meeting request and removes the meeting from your 

calendar. 

3. In the drop-down menu that appears, select one of the following:  

 Edit the Response before Sending: This allows you to include a message with your response. 

 Send the Response Now: Sends a response immediately. 

 Do Not Send a Response: If you choose this option the meeting organizer won't be notified whether 

or not you'll be attending. Avoid using this option. 

 

 

 

 

 

 

 

 

 

 

 

When attendees accept and send their replies to your meeting request, the replies appear in your Inbox. 

Similar to 2013 
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Tracking Attendees 

You can easily check which attendees have accepted, declined, or have not responded to an invitation. 

1. Click on the Tracking button on the Meeting toolbar. 

2. Under the Response column check the attendees' responses. You can also manually change the 

attendees' responses by clicking on the drop down and selecting from the list. 

 Remember that the Tracking button only appears after the meeting invitation is sent out. 

 

Meeting Tab / Scheduling 
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Updating and Canceling Meetings 

 

You might find it necessary to change the date, time, or location of a meeting after you send the meeting 

request. As the meeting organizer, you can change any information in a meeting request at any time, 

including adding or removing attendees, or canceling the meeting. 

To edit a meeting request, double-click the meeting on your calendar. If the meeting is one of a series (a 

recurring meeting), Outlook prompts you to indicate whether you want to edit the meeting series or only 

the selected instance of the meeting. Make the changes you want, and then send the meeting update to 

the attendees. Each attendee will receive a meeting update message. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Changes to meeting details are tracked so that attendees can quickly identify them. 

To cancel a meeting, click the meeting on your calendar, or open the meeting window. 

1. Click on the Cancel Meeting button on the Meeting tab. 

2. Click on the Send Cancellation button. 
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3. Attendees will receive a notice that the meeting has been cancelled. The notice contains a link to 

automatically remove the cancelled meeting from their calendar. 

 

 

 

 

 

 

 

 

After you edit or cancel a meeting, Outlook sends an updated meeting request to the invited attendees 

to keep them informed. If the only change you make is to the attendee list, Outlook gives you the option 

of sending an update only to the affected attendees. 

 

Viewing the Calendar 

 

The Calendar module offers four distinct views of content, which are available from the Change View list 

in the Current View group on the View tab. These views are: 
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Calendar. This is the standard view in which you display your Outlook calendar. In the Day, Work Week, 

or Week arrangement, Calendar view displays the subject, location, and organizer (if space allows) of each 

appointment, meeting, or event, in addition to the availability bar and any special icons, such as Private 

or Recurrence. 

Preview. In the Day, Work Week, or Week arrangement, Preview view displays more information, including 

information from the notes area of the appointment window, as space allows. 

List. This list view displays all appointments, meetings, and events on your calendar. 

Active.  This list view displays only future appointments, meetings, and events. 

 

You can use these additional tools to change the time period shown in the calendar: 

 Display the previous or next time period by clicking the Back button or the Forward button next to the 

date or date range in the calendar header. 

 Display the current day by clicking the Today button in the Go To group on the Home tab. 

 Display a seven-day period starting with the current day by clicking the Next 7 Days button in the Go 

To group on the Home tab. 

 Display week numbers to the left of each week in Month view and in the Date Navigator. If you 

implement this option, you can click the week tab to display that week. 

 

You can use the Date Navigator to change the day or range of days shown on the calendar. 

 

 

 

 

 

 

 

 

By default, the Outlook 2013 Calendar module displays the current month and next month in the Date 

Navigator at the top of the Folder Pane. You can display more or fewer months by changing the width or 

height of the area allocated to the Date Navigator. 
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You can allocate up to 50 percent of the program window to the Folder Pane. 

 

Sharing Calendar Information 

 

Co-workers can view your available working time when they schedule meetings with you or view your 

calendar through Outlook. If you want to share more information with co-workers or with people outside 

of your organization, you have several options for doing so. 

If your email address is part of an Exchange network, you can give permission to other people on your 

network to view, modify, or create items within a calendar or any other type of Outlook folder. The level 

of access each co-worker has is governed by the permissions you assign to him or her. 

To share a calendar with a co-worker: 

1. In the Calendar module, display the calendar you want to share. 

 Organize Tab / Permissions 
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2. On the Home tab, in the Share group, click the Share Calendar button to create a message, called 

a sharing invitation.  

3. Add ess the essage to the pe so  ith ho  ou d like to sha e ou  ale da . If ou d like to 
request that the person reciprocate by sharing his or her calendar with you, select the Request 

pe issio  to ie  e ipie t s Cale da  check box.  

 

 

 

 

 

 

 

 

 

 

 

 

 

4. In the Details list, click the level of detail you want to share: Availability only, Limited details, or Full 

details. 

5. Add any notes you want to in the content pane, send the message, and then click Yes in the 

Microsoft Outlook dialog box that asks you to confirm that you want to share the calendar with 

the specified permissions. 
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After you share a calendar, you can specify the actions each person with whom you share the calendar 

can take. On the Permissions page of the Calendar Properties dialog box, which you display by clicking the 

Calendar Permissions button in the Share group on the Home tab, you can select a permission level, which 

includes specific Read, Write, Delete, and other settings, or you can select individual settings in each 

category. 

From the Permissions page, you can change the default permission level to your calendar and permit co-

workers to view more information than only your availability. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can delegate control of your calendar so that a co-worker or assistant can create and respond to 

meeting requests on your behalf, and specify that meeting requests should be delivered to your delegate 

rather than to you. You receive copies of the meeting requests and copies of ou  delegate s espo ses, 
ut ou do t ha e to espo d. 
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To delegate control of your calendar to another Outlook user, follow these steps: 

1. On the Info page of the Backstage view, click Account Settings, and then click Delegate Access. 

2. In the Delegates dialog box, click Add to open the Add Users dialog box.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. In the Add Users dialog box, click the person you want to delegate control to, click Add, and then 

click OK to open the Delegate Permissions dialog box. Notice that you can delegate individual 

permission levels for each module. 

4. In the Delegate Permissions dialog box, set the permission level you want the delegate to have for 

each module.  

5. Select the Auto ati all  se d a essage… check box to ensure that your delegate is aware of the 

pe issio s ou e delegati g to hi  o  he . 
6. If you want to allow your delegate to view details of items that you mark as private, select the 

Delegate can see my private items check box. 

 

 

 
Tools Menu / Accounts / Advanced / Delegates Tab 
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7. In the Delegate Permissions dialog box, click OK. The delegate appears in the Delegates dialog box. 

You can modify the delegation permissions for an existing delegate, or rescind the delegation, at 

any time.  

 

Che ki g Othe  People s Cale da  

 

1. Select Calendar in the Navigation pane. 

2. Right click on Shared Calendars and select Add Calendar From Address Book. 

 

 

 

 

 

 

 

 

 

 

3. Enter the name of the colleague whose calendar you want to view for Name or click Name to select 

a name from the Address Book, select a name and click OK. 

4. Click OK. The shared Calendar appears adjacent to any calendar that is already in the view. 

Organize Tab / Open Calendar 
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Printing a Calendar 

 

Printing the Calendar is no different than printing anything else in Outlook, except for a few unique 

Calendar-related options that you need to be aware of. You can customize the Calendar print settings so 

your printed calendar looks the way you want it to. 

The availa le p i t st les a  ased o  hat ie  ou e i  he  ou hoose the P i t o a d. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The default print styles include the following: 

 Daily Style Prints the selected date range with one day per page. Printed elements include the 

date, day, TaskPad, reference calendars for the current and upcoming months, a breakdown of working 

hours in 30-minute blocks, and an area for notes. 

 Weekly Agenda Style Prints the selected date range with one calendar week per page, including 

reference calendars for the selected and following month. 

 Weekly Calendar Style Prints the selected date range with one calendar week per page. Each page 

includes date range and time increments for working hours, and reference calendars for the selected and 

following month. 

File Menu / Print 
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 Monthly Style Prints a page for each month in the selected date range. Each page includes the 

selected month with a few days showing from the previous and subsequent months, along with reference 

calendars for the selected and following month. 

 Tri-fold Style Prints a page for each day in the selected date range. Each page includes the daily 

schedule, weekly schedule, and Task Pad. 

 Calendar Details Style Lists your appointments for the selected date range, in addition to the 

accompanying appointment details. 

 

You can select the date or range of dates to be printed and modify the page setup options to fit your 

needs. 

 

 

Defining Your Available Time 

 

In your Outlook calendar, the time that you indicate you are available for other people to schedule 

meetings with you is referred to as your work week. 

By default, the Outlook work week is defined as from 8:00 A.M. to 5:00 P.M. (in your local time zone), 

Monday through Friday. You can change this to match your individual work schedule. In Outlook 2013, 

you can specify a start time and end time for your standard work day, specify the days of the week that 

ou o k, a d spe if  the da  of the eek that ou d like to appea  fi st he  you display only the work 

week in your calendar. 

1. On the Home tab, click the Arrange dialog box launcher to display the Calendar page of the Outlook 

Options dialog box.  

 

 

 

 

The work week settings are located in the Work time section at the top of the page. 

2. Define the days and times that you are available to meet with co-workers. 

 

 

 

 

 

 

 

Outlook Menu / Preferences / Calendar 
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Setting Out of Office Message 

 

1. Open Outlook.  

2. Click the File tab. 

3. Click the Automatic Replies (Out of Office) button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Adding national and religious holidays to your calendar 

You can easily add the holidays of a specific country or religion to your Outlook calendar. To do so, follow 

these steps: 

1. Display the Calendar page of the Outlook Options dialog box. 

2. In the Calendar Options section, click the Add Holidays button to open the Add Holidays to Calendar 

dialog box. 

 

The holidays of more than 110 countries are available to add to your calendar. 

3. Select the check boxes of the locations or religions whose holidays you want to add to your 

calendar, and then click OK. 

 

Afte  Outlook adds the sele ted ou t s holida s to ou  ale da , li k OK in the confirmation message 

box and in the Outlook Options dialog box.  

Tools Menu / Out of Office 
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4. Click the Send automatic auto-replies button. 

5. Check the Only send during this time range box.  

6. Next enter a Start and End time in the box as seen below. 

 

 

 

 

 

 

 

 

 

7. In the Inside My Organization tab insert the message you wish to be sent out. 

8. In the Outside My Organization tab insert the message you wish to be sent out to people 

outside of your organization. 

9. Click OK. 
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Working with Tasks 
 

 

 

 

 

 

 

 

 

 

 

 

Creating Tasks 

 

Recording your tasks makes them easier to remember and manage. Outlook tasks provide a great way to 

organize what you need to get done. 

In Outlook, you can create a task item that you can track until completion, or you can create a to-do item. 

A to-do item is an e-Mail message or contact that has been flagged for follow-up. All these items appear 

in the To-Do List. I  this lesso , e ll look at ho  to add a task o  eate a to-do item from a message or 

contact. 

 

Creating a Task 

1. Click the Tasks button in the Navigation Bar.  The To-Do List appears in Tasks. 

2. Click the HOME tab on the Ribbon and click the New Task button in the New group. A Task item 

window appears. 

 

 

 

 

 

 

IN THIS CHAPTER 

Creating Tasks 

Updating Tasks 

Changing Task Views 

Assigning a Task 

Completing a Task 

Printing Tasks 

 

If you use Microsoft Outlook 2013 on a daily 

basis, you might find it far easier to use the built-

in task-tracking functionality. You can add tasks, 

flag messages for follow-up, assign due dates, 

receive reminders, and mark tasks as complete 

when you finish them. You can even assign tasks 

to other people, and if those people use Outlook, 

you can view their progress on assigned tasks as 

they track progress milestones. 

Similar to 2013 
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3. Enter a subject and other information about the task. The table to the right provides an overview 

of the fields available in the task item window. 

4. Enter task details in the text area 

5. Click the TASK tab on the Ribbon and click the Save & Close button in the Actions group. 

When you create a task item, the only information you really need is the subject. As with many other 

types of Outlook items, you can set several options for tasks to make it easier to organize and identify 

tasks. 

Start Date  Specifies the date when the task will appear in the Tasks list as a reminder. 

Due Date  Specifies the when the task must be completed. 

Status  Specifies the status of the task: Not Started, In Progress, Completed, Waiting on 

Someone else, or Deferred. 

Priority  Specifies the importance level of the task: Low, Normal, or High. 

% Complete  Specifies the percentage of the task that is finished. 

Reminder  Displays a reminder for the item. The reminder appears until you dismiss it or mark 

the task as complete. 

Owner  Specifies the name of the person who created the task. If the task is sent to another 

person, that person becomes the owner of the task. 
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Creating a To-do Item 

A to-do item is any Outlook item, such as a task, e-Mail, or contact that has been flagged for follow-up. 

Tasks are automatically flagged as to-do items when you create them, while you must flag e-Mails and 

contacts yourself. 

 Right-click an e-Mail message or contact, point to Follow-up, and select a follow-up flag. 

The item is marked for follow-up, as shown in the example to the right, and will appear in Tasks, as shown 

in the example below. 

Flagging an e-Mail message or contact creates a to-do ite , ut does ’t eate a e  task. 
Because the to-do item is still an e-Mail essage o  o ta t afte  ei g flagged, ou a ’t assig  
it as a task to someone else or track its progress or percentage of completeness. You can move 

the message between mail folders, but deleting the message also deletes it from the to-do item list. 

 

 

 

 

 

 

 

 

 

 

Creating Tasks from Outlook Items 

You frequently need to take action based on information you receive in Outlook—for example, 

information in a message or in a meeting request. You might want to add information from another 

Outlook item to your task list, to ensure that you complete any necessary follow-up work. 

 Drag the item to the Tasks link or button on the Navigation Bar, and when a plus sign appears 

next to the cursor, release the mouse button. 

This method opens a task window that already has information filled in from the original item. You can 

change settings, add information and attachments, assign the task to other people, and make other 

changes. 
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Creating a Recurring Task 

If you have a task that you do on a regular basis you can create a recurring task that automatically repeats. 

1. Click the TASKS button in the Navigation Bar. 

2. Click the HOME tab on the Ribbon and click the New Task button in the New group. A Task item 

window appears. 

3. Enter the task information.  
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4. Click the TASK tab on the Ribbon and click the Recurrence button in the Recurrence group. 

The Task Recurrence dialog box appears. I  the ‘e u e e patte  a ea, ou tell Outlook he  a d 
how often the task recurs. You have several choices here: 

 Daily: Tasks that recur every day or every work day. 

 Weekly: Tasks that recur on the same day(s) of the week, such as a report due every Friday or a 

payroll due every other Thursday. 

 Monthly: Tasks that recur on every month, such as an inventory audit that occurs on the 5th of 

every month. 

 Yearly: Tasks that recur annually, such as tax. 

 

 

 

 

 

 

 

 

 

 

 

5. Select a recurrence pattern. The options to the right will change based on whether you selected 

Daily, Weekly, Monthly, or Yearly. 

6. Select additional recurrence options from the options that appear, then set the start and end date 

i  the Range of recurrence  a ea. 
7. Click OK. 

 

To stop the task from recurring, open the task, click the Recurrence button in the Recurrence group 

on the Ribbon, and select Remove Recurrence. 

To skip just the current occurrence of a recurring task, open the task and click the Skip Recurrence 

button in the Recurrence group on the Ribbon. 
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Updating Tasks 

 

Tasks generally appear on the Outlook task lists by start date or due date. You can change the details or 

dates of a task, o  t a k the p og ess ou e ade o  it. 

To update the status of a task:  

1. Open the task window. 

2. In the % Complete list, enter or select (by clicking the arrows) the percentage of the project you 

estimate as complete to change the status to reflect your selection. Tasks that are 0% complete 

are Not Started, tasks that are 1% to 99% complete are In Progress, and tasks that are 100% 

complete are Completed. 

3. If you want to manually change the task status—for example, to Deferred or Waiting on someone 

else—click that option in the Status list. 

4. “a e a d lose the task to update the task oth i  ou  o  task list a d i  the task o igi ato s 
task list. 

 

You a t t a k the status of a flagged essage. 

 

 

Not Applicable 
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Sending a Status Report 

You can send an e-Mail to i fo  so eo e else of the p og ess ou e aki g o  a task. 

1. Click the Tasks button in the Navigation Bar.  

2. Double-click the task you want to work with. The Task item window appears. 

3. Click the TASK tab on the Ribbon and click the Send Status Report button in the Manage Task. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Not Applicable 
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An e-Mail message containing a report about the task item appears. It includes the start and due dates, 

current status, % Complete, the Date completed (if it has been completed), and the number of hours 

spent on the task. 

 

 

 

 

 

 

 

4. Enter a recipient in the To box, type a message, and click the Send button. The message is sent. 

 

 

Changing Task Views 

 

In the Tasks module, you can display the To-Do List folder, which includes both tasks and flagged 

messages, or the Tasks folder, which includes only tasks. Outlook provides many options for viewing and 

arranging the contents of each folder. You can create additional folders to contain task items if you want 

to. 

The main place to keep track of tasks and to-do items is in the Tasks area. 

1. Click the Tasks button in the Navigation Bar. 

2. Click the HOME tab on the Ribbon and click the Change View button in the Current View group. 

 

 

 

 

 

 

 

 

 

 

Organize Tab / Arrange By 
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Detailed  Displays many details about each task, including color category and percentage 

complete. 

Simple List  Displays a few details so you can see your tasks at a quick glance. The In Folder 

column tells you whether the to-do item is a flagged e-Mail item or a task. 

To-Do List  Displays all tasks and to-do items with very little detail. Also displays Reading Pane. 

Prioritized  Displays all tasks in order of priority in a list. 

Active  Displays tasks that are incomplete (including overdue ones) in a list. 

Completed  Lists all tasks that have been marked complete. 

Today  Displays a list of all tasks due today. 

Next 7 Days  Displays tasks that are due in the next seven days in a list. 

Overdue  Displays tasks that are overdue in a list. 

Assigned  Shows only the tasks that have been assigned to others, sorted by the task owner's 

name and due date. 

Server Tasks  Displays a lists of tasks stored on the server. 

 

3. Select the view you want to use. 

4. Double-click a task to view it. 

 

In Tasks, you can use the Instant Search feature to find tasks and to-do items. Simply enter search 

keywords in the Search Tasks box at the top of the Tasks list screen or in the Search To-Do List box 

at the top of the To-Do List screen 

To help you organize and locate tasks, you can assign color categories to them. 

 

View tasks in the To-Do Bar 

You can also keep tabs on your tasks and to-do items using the To-Do Bar. 

1. If necessary, click the To-Do Bar drop-down in the Layout group button and select Tasks. 

The expanded To-Do Bar appears on the right side of the screen. At the bottom of the To-Do Bar, below 

the calendar and appointments, you can see all your tasks and flagged to-do items. 

2. Double-click a task to view it. 

 

 

 

 

Not Applicable 
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View tasks in Calendar 

You can also access your tasks in the Daily Task List in Calendar. 

1. Click the Calendar button in the Navigation Bar. 

The Calendar appears. In Day and Week views you can see a Tasks area beneath the calendar. Here you 

can view and work with tasks and to-do items. If it is not showing, click the Daily Task List button in the 

Layout group on the VIEW tab. 

2. Double-click a task to view it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Assigning a Task 

 

Besides creating tasks for yourself, you can assign a task to someone else. A task request is sent by e-Mail, 

and the recipient can accept or decline it. 

To delegate a task to another Outlook user: 

1. Open the task in the task window. On the Task tab, in the Manage Task group, click the Assign Task 

button. 

 

2016 Not Applicable 

2011 Tools Tab / My Day 

Not Applicable 
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2. In the To box that appears in the task header, enter the name or email address of the person you 

want to assign the task to. 

 

3. Review the task subject, dates, status, priority, and completion settings and ensure that they are 

as you want them—after you assign the task, you will no longer be able to change the task details. 



 

Outlook 2013   82 

4. Make sure the Keep an updated copy of this task on my task list and Send me a status report when 

this task is complete check boxes are selected. 

5. In the task header, click the Send button. If a message box notifies you that the task reminder has 

been turned off, click OK to send the task request and notify you when the assignee accepts or 

declines the task. 

 

Accept or decline an assigned task 

To accept, decline, respond to, or reassign a task request: 

1. Accept or decline the task from the Reading Pane, or open the task request to see additional 

options for managing the task request on the Task tab of the task window ribbon.  

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Take one of the following actions: 

 In the Respond group, click the Accept button to accept the task or the Decline button to decline 

the task, and send the associated response to the task owner. 

 In the Respond group, click Reply to send a message to the task owner without accepting or 

declining the task, or the Forward button to forward the task content to another person without 

reassigning the task. 

Once you mark the task’s status as Co plete, a  e-Mail will be sent to the person who assigned 

the task, otif i g hi  o  he  of the task’s o pletio . 

 

 

 

Not Applicable 
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Forward a task 

If you just want to send a copy of a task to someone without assigning it to that person, you can forward 

the task. 

1. Click the Tasks button in the Navigation Bar. The To-Do List appears. 

2. Right-click the task you want to forward and select Forward from the contextual menu. An e-Mail 

message appears with the task included as an e-Mail attachment. 

3. Enter the e-Mail address of the person you want to send the task to and click the Send button. The 

task is sent. 

 

 

Completing a Task 

 

Whethe  ou e o pleted a task, gi e  up o  it, o  a e othe ise th ough ith it, at so e poi t ou e 
going to want to clear some tasks off ou  list. I  this lesso , e ll look at ho  to go a out o pleti g, 
clearing, and deleting tasks.  

Mark as complete 

You can mark tasks and to-do ite s as o plete o e ou e do e ith the . 

1. Click the Tasks button in the Navigation Bar. The To-Do List appears. 

2. In Simple List view, click the Complete check box next to the completed task. The task appears with 

a line through it to let you know it is complete. 

 

 

 

 

 

Other Ways to Mark a Task as Complete:  

 Right-click a task a he e it s displa ed a d sele t Mark Complete from the contextual menu.  

 Cli k the ite s flag.  

 Open the task s ite  i do , li k the Status list arrow, and select Completed or enter 100% in 

the % Complete box. 

 

Clear a follow-up flag 

You can remove to-do items that are not tasks—such as e-Mail messages marked with a flag for follow-

up—from the To-Do List  lea i g the ite s flag. 

Not Applicable 

Similar to 2013 

Similar to 2013 
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Right-click the to-do item and select Follow Up → Clear Flag from the contextual menu. The item is no 

longer flagged and is not included on To-Do List. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

What’s the diffe e e et ee  lea i g a flag a d a ki g it as o plete? Ma ki g a to-do item 

as complete is better for your records because it still appears in the to-do list. By clearing a flag, 

it’s as though the ite  as e e  flagged, hi h a  ause o fusio  i  the futu e. 

 

Delete a task 

You a  also delete a task hethe  it s o pleted o  ot. 

1. Select the task. You can select the task in the To-Do List, Task list, To-Do Bar, or Calendar. 

2. Click the HOME tab on the Ribbon and click the Delete button in the Delete group. The task is 

deleted. 

 

 

 

 

 

Similar to 2013 
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Printing Tasks 

 

You can print a list of your tasks or just individual tasks. 

Print a task list 

1. Click the Tasks button in the Navigation Bar. Whichever list is visible will be the one that is printed. 

If ou a t o l  tasks to e p i ted, ake su e the Tasks list is displa ed. If ou d athe  p i t all 
your to-do items, make sure the To-Do List is displayed. 

2. Click the FILE tab on the Ribbon and select Print. Options for printing your Tasks appear. 

3. Click the Print button. The list prints. 

 

Only Table Style is available for printing tasks. The exceptions are the Active and Assigned views, 

which also have Memo Style. 

 

Print a task item 

1. Click the Tasks button in the Navigation Bar. The To-Do List appears. 

2. Double-click the task you want to print. The Task item window appears. 

3. Click the FILE tab on the Ribbon and select Print. Options for printing your Tasks appear. 

4. Click the Print button. The task prints. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Similar to 2013 

File Menu / Print 
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More Outlook Features 
 

 

 

 

 

 

 

 

 

 

 

Creating and Using Search Folders 

 

Search Folders are valuable e-Mail organization tools. Unlike the other Outlook folders, Search Folders 

are virtual folders that display messages that match specific criteria. The message themselves are stored 

in other Outlook folders, such as the Inbox. 

Be ause ou do t ha e to o sta tl  o e a d op  ite s to othe  folde s i  Outlook, “ea h Folde s 
are easy to use and are more effective for sorting and organizing than standard folders. 

Create a custom Search Folder 

You can create your own custom Search Folders to view e-Mail messages. 

1. Right-click on the Search Folders button on the Navigation Pane and select New Search Folder. 

 

 

 

 

 

 

The New Search Folder dialog box appears. You can create a new Search Folder using one of the options 

in the list. All you need to do is select an option and enter any additional criteria. You can also create a 

custom Search Folder to meet more specific criteria. 

 

IN THIS CHAPTER 

Creating and Using Search Folders 

Setting Email Rules 

Using Mailbox Cleanup 

Manually Archiving and Retrieving 

Information 

Dealing with Junk Email 

Microsoft has set up the program to function in 

the way that will be of the most use to the most 

people, but the fact is that each of us has a 

different working style and has different needs 

for our working environment. Fortunately, you 

can configure many aspects of the appearance 

and functionality of Outlook 2013 to make it the 

most efficient platform for the way you work. 

Smart Folders 



 

Outlook 2013   87 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Select Create a custom Search Folder from the bottom of the list and click the Choose button. The 

Custom Search Folder dialog box appears. 

3. Type a name for the Search Folder in the Name box. Choose a name that describes the Search 

Folder. 

 

 

 

 

 

 

 

 

 

4. Click the Criteria button. The Search Folder Criteria dialog box appears. Here you can select criteria 

on the Messages, More Choices, and Advanced tabs. 
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5. Enter criteria for the Search Folder and click OK.  

6. Click the Browse button. The Select Folder(s) dialog box appears.  

7. Select the folders you want to search and click OK. Your Search Folder is created; you simply need 

to exit the dialog boxes. 

8. Click OK twice. The dialog boxes closes, and your Search Folder appears in the Navigation Pane. 

 

 

 

 

 

 

Setting Email Rules 

 

You can have Outlook evaluate your incoming or outgoing email messages and take various actions with 

them based on sets of instructions you set up, called rules. You can create rules based on different 

message criteria, such as the message sender, message recipients, message content, attachments, and 

importance. By using rules, you can have Outlook move, copy, delete, forward, redirect, reply to, or 

otherwise process messages based on the criteria you specify. You can choose from a collection of 

standard rules or create your own. 

 

Home Tab / Rules / Create Rule 
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1. On the Info page of the Backstage view, click the Manage Rules & Alerts button to display the Email 

Rules page of the Rules and Alerts dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. On the E-mail Rules page, click New Rule to start the Rules wizard. You can base a rule on one of 

the nine rule templates provided by Outlook, or you can start from a blank rule for incoming or 

outgoing messages. The wizard leads you through the steps of creating a standard or custom rule. 

3. Under Step 1: Select a template, select the template that you want from the Stay Organized or 

Stay Up to Date collection of templates.  

4. Under Step 2: Edit the rule description, click an underlined value. For example, if you click the 

people or public group link, the Address Book opens. 

5. Click Next. 

6. Under Step 1: Select condition(s), select the conditions that you want the messages to meet for 

the rule to apply. 

7. Under Step 2: Edit the rule description, click an underlined value for any condition that you added, 

and then specify the value. 

8. Click Next. 

9. Under Step 1: Select action(s), select the action that you want the rule to take when the specified 

conditions are met. 
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10. Under Step 2: Edit the rule description, click an underlined value for any action that you added, 

and then specify the value. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

11. Click Next. 

12. Under Step 1: Select exception(s), select any exceptions to the rule, and then click Next. 

13. Under Step 2: Edit the rule description, click an underlined value for any exception that you added, 

and then specify the value. 

14. Click Next. 

15. Under Step 1: Specify a name for this rule, enter a name. 

16. Under Step 2: Setup rule options, select the check boxes for the options that you want. 

 If you want to run this rule on messages that already are in the Inbox, select the Run this rule now 

on messages already in "Inbox" check box. 

 By default, the new rule is turned on. To turn off the rule, clear the Turn on this rule check box. 

 To apply this rule to all email accounts set up in Outlook, select the Create this rule on all accounts 

check box. 
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17. Click Finish. 

 

 

Using Mailbox Cleanup 

 

Like a physical Mailbox, your Outlook Mailbox fills up over time. Knowing the size of your Mailbox, the 

amount of free space you have, and how to clean up your Mailbox helps keep things organized. 

You should periodically empty your Mailbox. Use the Mailbox Cleanup dialog box to help you empty 

Outlook of unnecessary or duplicate items. 

1. Click the FILE tab on the Ribbon and select Info. Information about your e-Mail account appears. 

 

 

Organize Tab / Arrange By Size 
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2. Click the Cleanup Tools button and select Mailbox Cleanup. The Mailbox Cleanup dialog box 

appears. Use any of the following methods to reduce the size of your Mailbox: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 View Mailbox size: Click the View Mailbox Size button to view the total size of your Mailbox as well 

as the size of each folder. 

 Find items: Search for items to delete based on their age or size. 

 Auto-Archive items: Archive old items. These items will still be available under Archive Folders in 

the Folder List. 

 Empty the Deleted Items folder: View the size of your Deleted Items folder and permanently delete 

items. 
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 Delete conflicts: View conflicts and delete any alternative versions of items in your Mailbox. 

3. Select the options you wish to use and follow the prompts. 

4. Whe  ou e fi ished, li k the Close button in the Mailbox Cleanup dialog box. Your changes are 

applied. 

 

Manually Archiving and Retrieving Information 

 

As your folders become larger, Outlook becomes slower, and finding items can become increasingly 

difficult. That is where archiving becomes useful. When you archive Outlook information, you transfer old 

items to a storage file. The items are then deleted from their original folder in Outlook. 

Because archived items are copied to the archive file and then removed from Outlook, be cautious about 

what you archive. This lesson explains how to archive Outlook information manually. 

1. Click the FILE tab on the Ribbon and click the Cleanup Tools button. A list of options appears. 

2. Select Archive from the list. The Archive dialog box appears. 

 

 

 

 

 

 

 

 

 

 

3. Make sure that the Archive This Folder and all subfolders option is selected. This option will let you 

specify which folder you want to archive. If you choose the other optio , A hi e all folde s 
a o di g to thei  AutoA hi e setti gs , e e  folde  i  Outlook e ept those ot set to a hi e  
will be archived. 

4. Select the folder that you want to archive. If you want to archive everything, select Mailbox and 

all the folders will be archived. Now choose the date at which you want to begin archiving. 

5. Click the Archive items older than list arrow and select the how old an item must be in order to be 

archived. All items older than the date specified will be moved into the archive file. Items that are 

newer remain in Outlook. 

 

 

 

Tools Menu / Rules 
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6. (Optional) Specify the name and location of the archive file in the Archive File box. The default 

location is a folder called Archive, and the archive is saved as an Outlook Data File (.pst). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On My Computer (Inbox) 
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Note: If you specify a new name and location for the archive file, make sure you use the same file when 

ou a hi e i fo atio  i  the futu e. Ne l  a hi ed ite s a e just added to the a hi e, so ou’ll a t to 
ake su e the ’ e all in the same place. 

7. Click OK. 

 

Access archived items 

Your archiving system is working great. Unfortunately, you need to find an e-Mail message archived two 

years ago. No problem – the archived items are just a few clicks away. 

1. Click the ellipsis button … on the Navigation Bar. Click the Folders button. The Folder List appears 

in the Navigation Pane. 

 

 

 

 

 

 

2. Select Archive Folders (or the name you specified for your archived items) in the Folder List. The 

archive appears. 

 

 

 

 

 

 

Dealing with Junk Email 

 

Unsolicited Mail, known as spam, is easily the most annoying aspect of e-Mail, a d it s i easi g at a  
alarming rate. When you get unwanted Mail, Outlook 2013 will automatically filter it into a separate 

folder, based on the content and structure of the message. It does t at h all spa , a d o asio all  a 
good message will end up in the Junk E-Mail folde , so it s a good idea to u de sta d ho  Outlook deals 
with spam. 

On the other hand, you might not be aware that one or more messages has been redirected to your Junk 

E- ail folde ; if so eo e tells ou that he o  she has se t ou a essage ut ou ha e t e ei ed it, it s 
a good idea to he k hethe  it s i  ou  Ju k E-mail folder. 

On My Computer (Inbox) 

Similar to 2013 
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You can display the contents of the Junk E-mail folder by clicking Junk E-mail in the Folder Pane. When the 

Junk E-mail folder contains one or more messages, the number of messages in the folder is shown in 

parentheses at the end of the folder name. If any of the messages in the folder have not been read, the 

folder name is bold. 

 

 

 

Outlook converts message content in the Junk E-mail folder to plain text and disables any active links or 

content within the message. The InfoBar in the message header provides specific information about the 

essage s status. 

Any remote graphics (graphics that are displayed from Internet locations rather than embedded in the 

message—sometimes called web beacons) that were present in the message are converted to URLs, 

which reveals where the graphics originated. 

To process a message from the Junk E-mail folder: 

 

1. Select or open the message you want to process. 

2. On the Home tab (if you selected the message) or the Message tab (if you opened the message), 

in the Delete group, click the Junk button to display the options for processing the message.  

 

 

 

 

 

 

 

 

 

3. Click one of the first four options in the Junk list to block the sender or to add the sender, the 

se de s do ai , o  the e ipie t g oup to ou  Safe Senders or Safe Recipients list. Clicking any of 

these options does not remove the message from the Junk E-mail folder. 

4. To move the message to your Inbox, click Not Junk. If you want to add the sender to your Safe 

Senders list, select the Always trust e-mail from check box in the Mark as Not Junk message box. 

Then click OK. 
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Configuring junk email options 

You manage junk mail settings from the Junk E-mail Options dialog box, which you open by clicking Junk 

E-mail Options in the Junk list. You set specific junk email processing options for each email account to 

which Outlook is configured to connect. The accou t fo  hi h ou e o figu i g optio s is sho  i  the 
title bar of the Junk E-mail Options dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 No Automatic Filtering: All e-Mail is moved to the Junk E-Mail folder, including e-Mail from blocked 

senders. 

 Low: Only the most obvious junk e-Mail messages are moved to the Junk E-Mail folder. 

 High: Most junk e-Mail is sent to the junk e-Mail folder, but some regular Mail may be caught as 

well. 

 Safe Lists Only: All Mail that does not come from your Safe Senders list will be sent to the junk e-

Mail folder. 

If you want Outlook to automatically delete suspected junk email, select the Permanently Delete 

Suspected Junk E-mail Instead Of Moving It To The Junk E-mail Folder check box. Do not select this 

check box if you set the protection level to High or to Safe Lists Only. With these settings, it is likely that 

the Junk E- ail Filte  ill at h uite a fe  alid essages that ou do ’t a t deleted. 
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Adding Addresses to the Safe and Blocked Senders List 

 On the Safe Senders page, you can add a spe ifi  pe so s e ail add ess to the “afe “e de s list 
(for example, tom@contoso.com) or specify that email received from any sender at a particular 

domain is safe by adding only the domain. 

 

 

 

 

 

 

 

 

 

 

 

 On the Safe Recipients page, you can add distribution lists or mailing lists of which you are a 

member to your Safe Recipients list.  

 

 

 

 

 

 

 

 

To ensure that messages from your 

legiti ate co tacts are ’t oved 
to the Junk E-mail folder, you can 

select the two check boxes at the 

bottom of the dialog box. 
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Challenge! 
 

Exercise 1.    Class preparation  

1. Locate the MS Outlook - training resources email you will have 

received 

2. Open the email and drag the attachments to the Drafts folder of 

your mailbox 

Exercise 2.    Customise Mail layout  

Each section of Outlook has a customizable content pane. This enables you to personalize your screen in 

each section. This is a local setting you will have to configure on your workstations.  

In the mail section  

1. Go to the View tab  

2. Click on the Reading pane button  

3. Select Off  

Using your mouse manually adjust the width of 

the:  

 Navigation pane  

 Reading pane   

 To-Do Bar  

Exercise 3.     Create and automate email signatures  

1. Click New Email  

In the new message:  

2. Go to the message tab  

3. Click Signatures > Signatures…   

4. Click New  

Create a new signature as a default signature for new emails. 

 

 

Exercise 4.    Send an email  

Start a New email 

1. Click the To… button  

2. Search for the recipient  

3. Select the user record   
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4. Click the To -> button  

5. Insert your new signature  

Add a contact as an attachment: 

1. Click the Insert tab on the email ribbon  

2. Click Outlook Item  

3. Select contacts folder and a contact item  

4. Insert multiple items with CTRL or SHIFT  

5. Click OK  

Check your spelling and grammar and always ensure the 

content is enterprise appropriate. Emails are persistent 

business documents. 

Exercise 5.    Manage email settings  

Adjust email notifications 

1. Click the File tab  

2. Select Options  

3. Click the Mail menu item in the Options dialogue box  

4. Uncheck the notification boxes as desired  

 

Exercise 6.    Adjust email viewing options  

Use conversation view 

Conversation view aggregates emails and summarizes them by subject. As you receive a new email 

with that subject the whole conversation moves to the top of your email list. This can include emails 

in other folders.  

1. Click the View tab  

2. Select Date in the Arrangement group  

3. Check Show as Conversations  

4. Select This folder button  

  

Color code incoming emails 

It is possible to use conditional formatting to color code incoming correspondence.  
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1. Click the View tab  

2. Click View Settings   

3. Click Conditional Formatting  

4. Click Add   

5. Type Manager in the Name field  

6. Click the Condition button  

7. Click the F o … button  

8. “ea h a d sele t ou  a age s a e 
from the address book then click OK  

 

 

 

 

9. Click the More Choices tab  

10. Check the Only items that are: checkbox  

11. Set the list item to unread  

12. Click OK  

13. Click the Font button  

14. Choose a font color  

15. Click OK   

16. Click OK to confirm the new condition  

17. Click OK to confirm the view change  

 

Until you receive a new email from your manager or mark an email as unread no emails 

will be highlighted according to this rule. 

  

  

  

  

  

    



 

Outlook 2013   102 

Exercise 7.    Applying flags and categories  

Email flags  

Use flags as a follow up reminder  

 Left click the Flag icon on any email   

 Left click again to indicate complete  

 Right click the Flag icon on any email for specific timeframes or to 

schedule a reminder  

Categories  

Establishing categories for managing mail will only apply to your own account.  Other users will be able 

to define and apply their own account  

Apply categories  

1. Right click in CATEGORIES section to access category menu  

2. Click on a category to apply  

This can be repeated to apply multiple categories.  

Apply a category with one click  

1. Right click in CATEGORIES section to access category menu  

2. Select the “et Qui k Cli k…   

3. Choose a category to be applied  

4. Click OK  

5. Left click on an email in the Categories section  

The defined category will be applied to selected messages. 

Customise Categories  

 Right click an email > All Categories  

OR  

 Click the Categorize tool in the Tags group on the 

Home tab  

 Select Rename or create New categories 

as required  
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Exercise 8.    Schedule an out of office message  

1. Click the File tab  

2. Click Automatic Replies  

You can add the Out of Office Assistant tool to your 

quick access toolbar.  

3. Click Send automatic replies to send replies until 

manually disabled  

  In addition: he k Only send during this time range  to   
schedule an automated period  

4. Enter a message/s which will be sent in response to 

any email during your absence  

5. Click the Rules button   

6. Click Add ‘ule…  

7. Check the Forward box and then click the To… 

button  

8. Select a colleague  

9. Click OK   

10. Confirm email forward for all emails by clicking Yes  

These rules will be used each time you schedule an out 

of office period unless they are disabled or deleted.  

11. Click OK to confirm the rules  

  

12. Click OK to schedule the out of office period  

 

To stop Automatic Replies  

13. Click on File  

14. Click on Automatic Replies button  

15. “ele t Do not send automatic replies  utto   

16. Click on OK  
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Exercise 9.    Customise calendar settings  

1. Click the File tab > Options  

2. Select the Calendar menu item  

Set work hours  

 Update work schedule to show others your 

usual work hours.  

This will adjust shaded sections on the days you 

select.  

Adjust default meeting reminder  

 Adjust the Default Reminders dropdown in  

Calendar options  

 

 

Exercise 10.    Share your calendar  

1. Go to Calendar section of Outlook  

2. Click Share Calendar in the Share group  

 

 

 

 

 

3. Choose recipients  

 

 

 

 

4. Check ‘e uest Pe issio  to ie  e ipie t s ale da  if appropriate  

5. Click Send 
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Customize sharing permissions  

1. Click Calendar Permissions on the Share group  

2. Select the staff member and update their permissions 

as required  

3. Click on OK  

  

Sharing your calendar enables Read permissions only. You 

will be required to customize the Write and Delete 

permissions as required.  

Exercise 11.    Schedule a meeting  

1. Return to the Mail section and select the Timesheet email  

2. Click the Meeting button in the Respond group  

When you click Send – meeting invitations will be sent 

out to recipients.  

3. Click the Scheduling Assistant button  

4. Add recipients  

5. Select a date and time, based on the displayed availability   

6. Click on Send  

 

 

Converting appointments and meetings 

 Convert meeting to appointment -> Click Cancel Invitation  

 Convert appointment to meeting -> Click Invite Attendees  
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Recurring appointments  

When setting up a meeting:  

1. Click the Recurrence button in the Options group  

  

2. Select recurrence options including frequency and 

an end date  

3. Click OK  

This offers an invitation to recipients to a series of 

meetings which will be entered into their calendar.  

  

Exercise 12.    Respond to meeting invitations  

An Outlook meeting invitation is an enhanced email with Yes, Tentative and No buttons on it. It is good 

practice to answer these invitations and to have Outlook send a response. This ensures that meeting 

organizers are aware of attendance and can reschedule if necessary.  

Click the email invitation:  

  

1. Click one of the attendance options: Accept/Tentative/Decline  

2. Choose the Send the Response Now option  

OR  

• Click Propose New Time with a provisional Tentative or Negative 

response  

• Alter the start and end times and click  

Propose Time  
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Exercise 13.    Print your calendar  

In the Calendar section:  

1. Click the File tab  

2. Click Print  

OR  

 Press CTRL + P  

3. Alter the Calendar print settings  

4. Click Print   

  

 

 

Exercise 14.    Add notes to a contact  

Go to the People section:  

1. Double click a contact  

2. Click Notes  

3. Add relevant notes about relevant interactions with this 

user  

Exercise 15.    Create a contact group  

A contact group is an email distribution list you can access from any of the address fields when creating 

an email or meeting.  

1. Click New Contact Group   

2. E te  the a e Outlook 2013 Course   

  

 



 

Outlook 2013   108 

  

3. Click Add Members > From Outlook Contacts  

4. Select contacts as appropriate  

5. Click Save & Close  

This group will now be available via autocomplete 

when you start typing a recipient when sending an 

email.  

 

Exercise 16.     Create a contacts folder  

Contact folders hold individual and groups of 

related contacts.  

1. In the Navigation Bar right click on the 

Contacts folder  

2. Click New Folde …  

3. T pe i  the a e: Outlook 2013   

4. Select the Contacts folder  

E su e a su folde  is t sele ted  

5. Click OK  
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Populate folder with contacts  

1. Select the Contacts folder  

2. Locate existing contacts and contact groups  

Changing the Current View to List may speed this 

process.  

3. Hold down the right mouse button over a contact and drag 

and drop it into the  

Outlook 2013  folde   

 

Exercise 17.    Share a contacts folder  

1. Select the Outlook 2013 contact folder  

2. Click Forward Contact in the Share group of the 

Home tab > As an Outlook Contact  

3. Add recipients to the email  

4. Click Send  

The contacts will be sent as an attachment.  

Save a contact attachment  

5. Click and drag the attachment over the Contacts 

section  

  

6. Drop the contact into a contacts folder    

 

Exercise 18.     Create a task  

In the Tasks section:  

1. Click New Task  

2. I  the “u je t field, t pe: Create new timesheet form   

3. Set the start date as today and the finish date one week 

from today  

4. Click Details in the Show group  

5. Add 2 hours  to the Total work: field  
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    You can now save this task for completion or assign it to 

someone.  

 

 

 

Exercise 19.    Assign the task  

1. Click Assign Task in the Manage Task group  

2. Add a recipient  

3. Add any relevant details  

4. Click Send  

 

 

 

Completing an assigned task  

 

In the Mail section when a task assignment arrives:  

1. Click Accept or decline as appropriate.  

2. Either send a custom response or simply an automated 

acceptance or rejection notification  

3. Hover on Tasks at the bottom to see a quick view of 

your tasks  
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4. Go to the Tasks section and click the   

Tasks list 

5. Double click the Task to update it including % complete  

6. Click Mark Complete when the task is completed  
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